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Preface 

Once you have your Apple® Macintosh® set up and the A/UX® operating 
system installed, you are likely to add peripheral devices such as printers 
and modems. Though the owner's guides accompanying your Apple 
peripheral devices describe how to physically connect the cables and 
power cords for the devices, they do not explain how to add the 
peripheral devices for use with A/UX. That's where this guide comes into 
play. It describes how to configure A/UX for the various peripheral devices 
you might want to add. 

Another task you will probably undertake is setting up user accounts for 
yourself and possibly others. This guide describes how to do this. 

This guide describes how to set up A/UX for the following: 

• a user account 

• Apple printers 

• Apple Hard Disk SCs 

• the AppieCD SC® 

• the Apple Tape Backup 40SC 

• an Apple Personal or Hayes-compatible modem 

• a Macintosh Plus or Macintosh SE as a terminal 

This guide also describes how to configure A/UX when connecting to an 
existing AppleTalk network. 
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How to use this guide 

A/UX users commonly add a printer or other peripheral device when they first set up their 
Macintosh to run A/UX. Then they add other devices as they need them. This guide is helpful in 
both instances. You can use it along with A/UY Installation Guide as you finish setting up your 
Macintosh with A/UX by adding a peripheral device. You can also refer to this guide later when 
you've aquired another peripheral device to add. 

Read the first chapter for an overview of system configuration. Then use the guide chapter by 
chapter as you need it. 

What you should already know 

You need to know the basic skills of using a Macintosh, such as double-clicking the mouse to 
open a file and how to press and drag down with the mouse to choose a menu command. This 
information is covered in Macintosh Essentials. You also need to be familiar with the 
information in A/UY Essentials on navigating through the A/UX system. 

Conventions used in this guide 

A/UX guides follow specific conventions. Words that require special emphasis appear in 
specific fonts or font styles. The following sections describe the conventions used in all 
A/UX guides. 
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Keys and key combinations 

Certain keys on the keyboard have special names. These modifier and character keys, often 
used in combination with other keys, perform various functions. In this guide, the names of 
these keys are in Initial Capital Letters followed by SMALL CAPITAL letters. 

The key names are 

CAPS LOCK 
COMMAND 
CONTROL 

ESCAPE SHIFT 
LEFT ARROW TAB 
RETURN UP ARROW 

DOWN ARROW RIGHT ARROW 

For example, suppose you enter 
Applee 

instead of 
Apple 

To erase the additional e, you would position the cursor (or insertion point) to the right of the 
word and press the DELETE key once. 

Sometimes you will see two or more names joined by hyphens. The hyphens indicate that you 
use two or more keys together to perform a specific function. For example, 

Press COMMAND-K 

means "Hold down the COMMAND key and press the K key." 

Terminology 

In A/UX guides, a certain term can represent a specific set of actions. For example, the word 
enter indicates that you type an entry and press the RETURN key. The instruction 

Enter 1 s 

means "Type 1 s and press the RETURN key." 
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Here is a list of common terms and the corresponding actions you take. 

Tenn 

Choose 

Click 
Drag 

Enter 
Press 

Select 
Type 

Action 

Activate a command in a menu. To choose a command from a pull-down 
menu, click once on the menu title while holding down the mouse button, 
and drag down until the command is highlighted. Then release the 
mouse button. 
Press and then immediately release the mouse button. 
Position the pointer on an object, then press and hold down the mouse 
button while moving the mouse. Release the mouse button when the 
object reaches the desired position on the screen. 
Type the letter or letters and press the RETURN key. 
Type a single key without pressing the RETURN key. Or position the 
pointer on an object and hold down the mouse button. 
Position the pointer on a selectable object and click the mouse button. 
Type an entry without pressing the RETURN key. 

The Courier font 

Throughout A/UX guides, words that you see on the screen or that you must type exactly as 
shown are in the Courier font. 

For example, suppose you see the instruction 

Type date on the command line and press RETURN. 

The word da t e is in the Co uri e r font to indicate that you must type it. 

Suppose you then read this explanation: 

Once you type date and press RETURN, you'll see something like this: 
Tues Oct 17 17:04:00 PDT 1989 

In this case, Courier is used to represent exactly what appears on the screen. 

All A/UX manual page names are also shown in the Courier font. For example, the entry ls(1) 

indicates that 1 s is the name of a manual page. 
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Font styles 

Words that you must replace with a value appropriate to a particular set of circumstances 
appear in italics. For example, if you see 
cat filename 

replace the italicized word with the name of the file you wish to view. If you want to view the 
contents of a file named E 1 vis, type the word E 1 vis in place of filename. In other words, 
enter 
cat Elvis 

New terms appear in boldface where they are defined. 

A/ux command syntax 

A/UX commands follow a specific command syntax. A typical A/UX command has 
this form: 
command (flag-option] [argument]. .. 

The following table outlines the elements of an A/UX command. 

Element 

command 

flag-option 

argument 

[] 

Description 

The command name. 
One or more optional arguments that modify the command. Most flag 
options have the form [-opt ... ]' where opt is a letter representing an option. 
Most commands have one or more flag options. 
A modification or specification of a command, usually a filename or symbols 
representing one or more filenames. 
Brackets used to enclose an optional item-that is, an item that is not 
essential for execution of the command. 
Ellipses used to indicate an argument that can be repeated any number 
of times. 
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For example, the we command is used to count lines, words, and characters in a file. Here is 
the full syntax for that command, including all possible flag options and the optional argument 
name. 
we [-cl [-1] [-w] [name .. .] 

Thus, you can enter 
we -w /Priseilla 

to count all of the words in the file /Priseilla, where we is the name of the command, -w is 
the flag option that instructs the command to count all of the words in the file, and the 
optional argument / P r is e i 11 a is the file to be searched. 

Command reference notation 

All1\'" Command Reference, All1\'" Programmer's Reference, and All1\'" System Administrator's 
Reference contain references for commands, programs, and other related information. Material 
is organized within these references by section numbers. The standard A/UX cross-reference 
notation is 

cmd (sect) 

where cmd is the name of the command, file, or other facility; sect is the section number where 
the entry resides. 

• Items followed by section numbers (IM), (7), or (8) are listed in 
All1\'" System Administrator's Reference. 

• Items followed by section numbers (1), (Ie), (lG), (IN), and (6) are listed in 
All1\'" Command Reference. 

• Items followed by section numbers (2), (3), (4), and (5) are listed in 
All1\'" Programmer's Reference. 

For example, 
eat(1) 

refers to the command eat, which is described in Section 1 of All1\'" Command Reference. 
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References can be also called up on the screen. Use the man command to display pages from 
reference manuals, known as manual pages, directly on the screen. For example, enter the 
command 
man cat 

to display the manual page for the cat command, including its description, syntax, options, 
and other pertinent information. To exit, press the Space bar until you see a shell prompt, or 
type q at any time to return immediately to your shell prompt. 

Cross-referencing 

An A/UX guide often refers to information discussed in another guide in the suite. The format 
for this type of cross-reference is "Chapter Title," Name of Guide. 

For a complete description of A/UX guides, see Road Map to A!UX. This guide contains 
descriptions of each A/UX guide, part numbers, and ordering information for all the guides in 
the A/UX documentation suite. 
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Chapter 1 About System Configuration 

A/UX® users frequently need more peripheral devices than their keyboards 
and monitors. There's usually a printer to connect, an extra hard disk to 
attach, and a modem or perhaps a terminal to add. This guide provides 
instructions on connecting the Apple® devices that can be used with a 
Macintosh® computer running the A/UX operating system and suggests 
ways to use those devices. 

If you are a novice A/UX user who is setting up a new A/UX system or 
adding Apple peripheral devices to an existing A/UX system, this guide and 
the owner's manual for the device you are adding are the only setup books 
you'll need (unless you are setting up or managing a computer network, in 
which case you'll need AlUX Network System Administration). This guide is 
also for the professional system administrator who oversees dozens of 
Macintosh computers and who desires quick instructions on how to attach 
peripheral devices to a single A/UX computer. 

In this guide you'll find instructions on adding the following to an 
A/UX system: 

• user accounts 

• LaserWriter® and ImageWriter® printers 

• Macintosh Plus and Macintosh SE computers as terminals 

• AppleCD SC® 

• Apple Tape Backup 40SC 

• additional Hard Disk SCs 

• Apple Personal Modem and Hayes-compatible modems 

• connection to an AppleTalk® network that is already set up 
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This guide discusses Apple devices only. For information on connecting 
third-party products to a Macintosh computer running A/UX, refer to the 
documentation for those products. 

Adding equipment and creating user accounts are just two of the tasks 
required of the system administrator. These tasks are simplified by several 
scripts in A/UX. A script is like a program but written in a small 
programming language called a command-line interpreter, and its purpose 
is to automate a repeated task. 

A/UX Local System Administration describes the many system 
administration tasks other than system configuration, such as making a 
plan for backing up files on a regular basis and checking the health of the 
A/UX file systems, all of which are beyond the scope of this guide. For 
complete documentation of system administration concerns, see A/UX 
Local System Administration. 

For information on designing, setting up, and administering a computer 
network, see A/UX Network System Administration. 
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What is system configuration? 

Whenever you add or remove users or devices to and from a Macintosh system running A/UX 
you are configuring the system. When you configure a system, you are the system 
administrator for the system. Configuring the system involves not only physically connecting 
the peripheral devices you want to use but also altering A/UX system files so that A/UX 
recognizes the devices. 

A/UX scripts ease the job 

System administrators often write scripts to reduce tedium in their job. This book shows how 
to use the A/UX scripts that simplify the tasks of adding user accounts and devices. 

A!UX Essentials describes the three user interfaces available in A/UX: the A/UX Finder, the 
CommandShell window with Commando dialog boxes, and the CommandShell window with 
the command-line interface. In this guide you'll use the configuration scripts with the 
Commando dialog boxes. A!UX Local System Administration describes how to use the scripts 
with the command-line interface. 

The scripts described in this book were written primarily with the Bourne Shell. The Bourne 
shell is a command-line interpreter and a simple programming language. For further information 
about the Bourne Shell and how to use it to write your own scripts, see AlUX User 
Interface Guide. 

The superuser and setting the root password 

Just as your bank account identifies you as a bank customer with certain privileges, all A/UX 
users have accounts that identify them and specify their privileges. 
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There are two kinds of A/UX users: normal users and the superuser. Normal users have user 
accounts and the superuser has the root account. The superuser can work with all A/UX files, 
including all the system files, whereas normal users can only work with three kinds of files: 

• files in their own user account 

• files that are accessible to them through a group they belong to 

• files that are explicitly made available to anyone using the computer 

Figure 1-1 illustrates how the normal user and superuser differ. 

See Chapter 2 of A/UX Essentials for more information on file permissions for normal 
user accounts. 

• Figure 1-1 The superuser's working environment and the normal user's 
working environment 
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D Important You need to assign a password to the root account to protect your 
system from illegitimate use. If you haven't yet assigned a password 
to the root account, follow the next steps to do so. D 

Assigning a password to the root account 

Follow these steps to assign a password to the root account only if you haven't already given 
a password to the root account (or if you want to change the root password). 

1. Start up AlUX. 

After the startup screens are displayed and A/UX is running, the login dialog 
box appears. 

2. Choose Change Password from the Options menu. 

The Change Password dialog box appears. 

Restrictions apply to the characters of a password. (For more information, see 
passwd(1) in AlUX Command Reference or see the same information displayed on 
screen by using the man command.) The requirements for a password are shown in 
the dialog box. 

3. Type root in the Name text box. 

4. Click the Old Password text box and type the old password if you are 
changing the password. 

5. Click the New Password text box and type a new password. 

6. Click OK. 

If your password is not accepted, modify it to meet the requirements and type 
it again. 

A dialog box asks you to confirm your new password. 

7. Type the new password again. 

8. Click OK. 
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The login dialog box appears again, with the login name and password boxes filled 
in. This gives you the opportunity to use the Options menu again, if you wish, before 
logging in. 

9. Click Login. 

You are logged in to A/UX. The root account now has a password, or a new password. 
You will have to enter it the next time you log in. 

The Finder appears so you can begin working. 

Becoming the superuser 

Any system administration task, such as adding a new user account, requires you to be the 
superuser. How you become the superuser depends on the state your computer is in. 

If AlUX is not running 

If A/UX is not running (if the computer is turned off or the Macintosh OS is running), follow 
these steps: 

1. Start up AlUX by turning on the computer. If you're using the Macintosh 
OS, double-click the AlUX icon. 

After the startup screens appear, the login dialog box appears. 

2. Click Registered User, unless it is already selected. 

3. Enter root in the Name text box. 

The computer prompts you for the password. If you haven't assigned one to the 
account, follow the steps in "Assigning a Password to the Root Account," in the 
previous section. 

4. Type the password. 

A grey rectangle expands through the Password box as you enter each character. 

5. Click Login or press RETURN. 
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If the password is correct, you are logged in to the root account and thus have the 
status of the superuser. 

If A/UX is running and you're already logged in 

If A/UX is running, and you are logged in to a user account, follow these steps to become 
the su peruser: 

1. In the Finder, choose Logout from the Special menu. 

The system reminds you to save all unsaved work. 

The Login dialog box appears, indicating you have logged out successfully. 

2. Follow the procedure in the previous section, "If A/UX is Not Running," 
beginning with step 2, to log in to the root account. 

Connecting devices 

Adding peripheral devices to A/UX usually requires two main steps: connecting the hardware, 
and adding the software that informs A/UX about that piece of hardware. 

There are limits to the number of peripheral devices you can connect to an A/UX system. The 
limits are imposed by the capacity of the ports, as described in the next two sections. 

Printers, modems, and terminals 

You connect printers, modems, and terminals through the two serial ports on the back of the 
Macintosh computer, as shown in Figure 1-2. 
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• Figure 1-2 The serial ports 

The two ports allow you to connect any two serial devices (printers, modems, and terminals) 
at one time. For information on adding devices through the serial port, see Chapter 3, "Adding 
and Managing Printers," Chapter 7, "Adding and Managing Modems," and Chapter 8, "Adding 
and Removing Terminals." 

Hard Disk SCs, AppleCD SC, and Tape Backup 40sc 

You connect Apple Hard Disk SCs, the Tape Backup 40SC, and the AppleCD SC through the 
SCSI port (Small Computer Systems Interface) port, shown in Figure 1-3. 

• Figure 1-3 SCSI port 

SCSI port 
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The Macintosh computer has just one SCSI port, but you can connect up to six external SCSI 
devices through it at one time by linking them together. (If you don't have an internal hard 
disk, you can connect seven external devices.) For example, you could have one Tape Backup 
40SC, one AppieCD SC, and five Hard Disk SCs connected simultaneously, as shown in 
Figure 1-4. 

• Figure 1-4 A SCSI port used to the maximum 

For instructions on adding SCSI devices, see Chapter 4, "Adding and Managing Hard Disk SCs," 
Chapter 5, "Adding and Managing the AppieCD SC," and Chapter 7, "Adding and Managing the 
Apple Tape Backup 40SC." 
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Chapter 2 Adding and Managing User Accounts 

Because each user has his or her own account, A/UX allows several users to 
work on the same computer, with security and privacy. 

A/UX is shipped with two user accounts: Guest and start. These accounts 
serve specific needs: the start account contains files for use with the A/UX 
tutorials in A!UX Essentials, and the Guest account allows a guest (that is, 
someone without a user account) to log in to the system. These two 
accounts are explained in more detail in A!UX Essentials. If you require 
more system security than this, you can either assign the Guest account a 
password, as explained in A!UX Essentials, or remove the account, as 
explained in the last section of this chapter. 

You need to add a user account for each individual who wants to use A/UX 
on a regular basis. 

This chapter describes how to 

• add user accounts 

• modify user accounts, for example, to share membership in a group 
with other user accounts 

• remove user accounts that are no longer necessary 
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Why create user accounts? 

A user account provides a secure and customized work environment. Security is provided by a 
password; only the person who knows the account's password can log in and use the account. 
This protects the files from outside tampering. (In contrast, the current Macintosh Operating 
System allows anyone who turns on the computer to work with all the files stored on that 
computer.) A customized work environment is provided through the choice between three 
login shells, group memberships with other accounts, and file-permission settings that 
determine who can do what with the files in the account. Users can change the file permissions 
on the files in their accounts and change their login shells, but they cannot change group 
memberships, as doing so requires superuser status. 

The system administrator is responsible for initially determining the characteristics for all user 
accounts. When you create an account with the adduser script, as described in this chapter, 
the account acquires the following characteristics, unless you make other choices: 

• the C shell as the login shell (the program used "behind the scenes" in 
CommandShell windows) 

• membership in a new group, of which the new user is the only member 

• the following access permissions on its files: 

user=rwx group=r-x others=---
r== read permission w==write permission x==execute permission 

The owner of the account can look at and make changes to all files and run all programs. 
Users who share group membership with this account can look at but not make changes to 
the files and can run all programs, while all other accounts cannot even look at the files. 

• a home directory in the / use r s directory 

Each user account has a home directory within / use r s. Don't confuse the / use r s 
directory with the /usr directory which contains the on-line manual pages, games, and 
other files. For more information on the importance of the distinction between these two 
directories, see Chapter 4, "Adding and Managing Hard Disk SCs." 

• a connection to the global System Folder 
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The global System Folder determines the fonts and desk accessories available to all users. A 
user can have a different set of fonts and desk accessories by adding a personal System 
Folder to his or her account. Because adding a personal System Folder is performed by the 
user, it is described in A/UX Essentials. 

In addition, you have the option to give an account a folder called Useful Commands. This 
folder contains commands deemed especially useful and is readily accessible because it 
resides in each user's account. A sample of the commands it contains are chmod (to change 
the permissions on a file) and man (to see information on the screen about an A/UX command 
rather than referencing a manual). 

Adding a new account 

With the following procedure, you add an account by using the Commando utility and the 
adduser script, which make the procedure simple and visual. For complete information on 
Commando, see Chapter 4, "Using Commando," in A/UX Essentials. 

Follow these steps to add a new user account: 

1. Log in to the root account. 

See Chapter 1 if you need instructions. 

2. Choose CommandShell from the Apple menu. 

A CommandShell window appears. 

3. Type adduser and press COMMAND-K. 

The adduser Commando dialog box appears, as shown in Figure 2-1. 
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• Figure 2-1 The adduser Commando dialog box 

~adduserOptions----------------------------------------~ 

r" Operation ··························· .. ·1 

i @ Rdd one user i 

I 0 Rdd many users I 
~ ................................................................... 1 
Login name: 

Room number: 

Office telephone: 

1 

I 
Real name: 

L-I ______ ---'. 1'---_____ -----'1 Home telephone: 

1 

[command line 
Ldduser 

( customiZing) ( Rdl.lanced options ) 

-Help Cancel 
Add a user account. You must be a super-user to use this command. If no 
names are given, you will be prompted interactively for all missing data. If If adduser 11 
Ye llow Pages are in use, new users must be added on the server. I! ~ 

4. Type the account owner's full name in the "Real name" text box. 

The insertion point (blinking vertical bar) is already in this box. 

Do not press RETURN after typing the name or you'll run the adduser command 
prematurely. If you inadvertently run the command, press CONTROL-C to get back to 
the CommandShell window where you can start again with step 1. 

See Figure 2-2 for an example of a typed user's name. Note that the name appears as 
part of the adduser command in the Command Line box. 
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• Figure 2-2 Entering the person's real name 

-adduser Options-----------------------. 
,. .. Operation .............................. ~ 

l @ Add one user l 
l 0 Add many users ! 
~ .............................. , .................................... 1 
Login name: 

r:command Line I adduse-r -r 'Tim Be-ar' 

Room number: 

Office telephone: 

Real name: 
I Tim Bea~ I Home telephone: 
~. ----~----~. ~I __________ ~ 

( Customizing) ( Aduanced options) 

r-Help Cancel 
Add a use-r account. You must be a supe-r-user to use- this command. If no 
name-s are given, you will be- prompte-d interactive-ly for all missing data. If If adduser 11 
Ye- llow Pages are in use, neow users must be adde-d on the serve-r. 1.1 e 

5. Click in the "Login name" text box and then type the login name for 
the account. 

You can also press the TAB key a few times to move to this text box, 

It is best to name the account with some part of the owner's name. For example, 
t imb is used for Tim Bear's account, as shown in Figure 2-3. This makes it easier to 
relate login names to the people who use them when you're doing such things as 
sending mail or using the who command to see who's logged in. Of course, if there 
are only two or three people with accounts on your system, you would not have 
trouble matching fanciful names to a person's proper name. 

Make an account name unique among the login names on your network. For example, 
if five people named Tim are on your network, you could distinguish their account 
names by forming them with some part of their first and last names. This makes it 
easier for users and for the system administrator to navigate the various computers 
and accounts on the network. 
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• Figure 2-3 Entering the login name 

,adduser Options---------------------., 
,'" Operation .............................. , 

! @ Rdd one user ! 
1 0 Rdd many users 1 

l ................................................................... 1 
login name: 

ltim~ 

[command line I :dduser -r 'Tim Bear' timb 

Room number: 

Office telephone: 

Real name: 
I Tim Bear I Home telephone: 
~. ----------~. ~I __________ ~ 

( customizing) ( Rdl.lanced options ) 

r-Help Cancel 
Add a user account You must be a super-user to use this command. If no 
names are given, you will be prompted interactively for all missing data. If If adduser D 
Ye 110w Pages are in use, new users must be added on the server. ~ .. 

6. Optionally, type the account owner's office address, and office and home 
phone numbers in the provided text boxes. 

To move from box to box, press the TAB key and not the RETURN key. The RETURN 

key has the effect of closing this dialog box and running the command. 

Typing information in these fields is optional. You can leave them blank without 
affecting the user account. This information is recorded in the / etc/pas swd file 
for future reference. 

The account is given the C shell as its login shell. The account also is assigned 
membership in a new group with an identification number but not a name, and in 
which this account is the sole member. If these are acceptable to you, continue with 
the following step to create the account. However, if you want to change the login 
shell or assign the account to a group by name, skip the next step and turn to 
"Modifying the Group Membership or Login Shell" later in this chapter. 

7. Click adduser. 
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You return to the CommandShell window and see the adduser command line that 
you built with Commando. 

8. Press RETURN. 

When the command finishes running, the screen displays information about the new 
account, which is ready for use. You can see an entry for the new account by entering 
ls /users. The home directory folder for the account will appear in the Finder 
when the user logs into the account, and the folder will bear the user's login name 

To assign a password to the new account rather than waiting for the account owner to assign it 
one, see "Adding a Password to an Account" later in this chapter. 

You're ready to create another user account if you wish. 

Modifying the group membership or login shell 

Selecting another login shell or adding the account to a group are common, easily effected 
changes to make while creating the account. The following procedures show you how. 

However, if you need to change file permissions on the account or change the directory in 
which the account is stored, see Chapter 3, "User and Group Administration" in AlUX Local 
System Administration. Also see that guide for instructions on changing an account once 
you've created it. That guide contains a complete reference on the adduser script. 

About groups 

Group membership allows users to look at and make changes to files in another group 
member's account. This capability requires that the permissions on the file and its containing 
directory allow read and write access to group members. If you want the owner of this user 
account to share such privileges with another user, you need to add it to a group. 

A group is identified by its group name or group ID number. Because a name is easier to 
remember than a number, this procedure refers to groups by name. 
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A/UX is shipped without groups. If you're creating the first group for your A/UX system, follow 
this procedure. Also follow this procedure if you're adding the account to an existing group for 
which you know the name. However, if you don't know the name of the group, you need to 
look at the jete/group file to find the name of the group before proceeding with 
these steps. 

1. Click Customizing. 

The Customizing dialog box appears, as shown in Figure 2-4. 

• Figure 2-4 The adduser Customizing dialog box 

-Customizing--------------------. 
: ... Shell .................................................................................... ·~ , .. ·Home directory .................................................. : 
! @ C shell ! l @ Subdirectory of lusers : 
! 0 Korn shell ! l 0 Subdir. of named directory : 
: 0 Bourne shell : ! 0 Specified eHplicitly ! 

ir~t~~r:!,,:!!!""':"""_mmml[ ! ~ !:::: ::::, ! ,::: ::: "!::~,~ ~ I 
Login group: ; ......................................................................................................... ; 

/1 
D Create Useful Commands folder 

r,command line 
Ldduser 

Cancel 

[

HelP I ( 
~ __________________ ~.n~--_co_n_t_in_u_e--#B 

2. From the Shell options select the login shell of your choice. 

3. Type the group name to which you want to add this account. 

If the group does not exist, create a name for the group by typing in this box. 

4. Click Continue. 

5. Click adduser. 
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You return to the CommandShell window. 

6. Press RETIrRN. 

When the command finishes running, the screen displays information about the new 
account, which is ready for use. You can see an entry for the new account by entering 
1 s / use r s. The home directory folder for the account will appear in the Finder 
when the user logs into the account, and the folder will bear the user's login name. 

Adding a password to an account 

A user account has no password until someone logs in to the account for the first time. At first 
log in, the account requires the person to assign it a password. Until the account has a 
password, anyone can log in to the account. If you require more system security, immediately 
log in to the account and assign it a password. Tell the account owner the password, and he or 
she can change it. 

If you need instructions on how to add a password, see AlUX Essentials. 

Removing a user account 

If a user account is no longer needed, you can remove its files from the disk to create space 
for other files. Of course, if the account contains valuable files, copy them to a floppy disk or 
tape cartridge, or in some way copy them before removing the account. When in doubt as to 
the value of the files in an account, make a backup of the files before removing the account. 
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The simplest way to copy a directory is to drag the directory folder icon to the icon of an 
empty floppy disk you inserted into a disk drive. Of course, if the directory is larger than the 
capacity of one floppy disk, you must select files in the directory and copy them to a floppy 
disk, and copy other files to additional disks until you have copied all the files in the 
directory. You have several other ways to make backup copies of A/UX files. For a complete 
description of the choices and for specific instructions on how to back up a directory, see 
Chapter 2, "Getting Around in AlUX," in AlUX Essentials. 

After the account is backed up, you can remove it. You remove a user account the same way 
you remove any directory. Follow these steps: 

1. Log in to the root account. 

2. In the Finder, open the / icon, then open the users folder. 

The contents of the use r s folder are displayed. 

3. Drag the user account folder to the Trash. 

4. Choose Empty Trash from the Special menu. 

The account's home directory is deleted. 
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Chapter 3 Adding and Managing Printers 

To print from A/UX you can either connect a printer directly to your 
Macintosh computer for exclusive use by yourself and others who may use 
your computer, or you can connect your computer to a network and use 
the printers available on the network. 

This chapter describes how to connect any Apple LaserWriter (except for 
the LaserWriter IISC) or ImageWriter printer directly to your Macintosh 
running A/UX. If you want to connect to a printer on an existing LocalTalk 
or TCP/IP network, skip this chapter and instead see Chapter 9, 
"Connecting Your Computer to a Network." 

To add printers not made by Apple, see "Setting Up Other Printers" in 
Chapter 7 of AJUX Local System Administration. 
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Adding a LaserWriter 

To connect a LaserWriter to a Macintosh running A/UX, you need two LocalTalk™ system 
connector kits-one kit to connect to the LaserWriter and one to connect to the Macintosh 
computer. LocalTalk system connector kits are available from your authorized Apple dealer. 

This section describes how to 

• add a LaserWriter to a Macintosh running A/UX 

• use the Chooser to select the printer you're going to use 

D Important A/UX does not support the LaserWriter IISe. 6 

When you are finished with the procedures in this section, you will have set up a small 
LocalTalk network between your Macintosh and your printer. Should you later wish to expand 
this network to include other computers or printers, refer to the IaealTalk Cable System 
Owner's Guide, which comes with each LocalTalk system connector kit, for 
further instructions. 

Connecting a LaserWriter 

To connect a LaserWriter to a Macintosh running A/UX, follow these steps: 

1. Unpack the LaserWriter and set it up with paper and a power source by 
following the instructions in the owner's guide, but don't connect it to 
your computer. 

2. Shut down AlUX. 

Choose the Shut Down command from the Special menu. 

3. Switch off the LaserWriter. 

4. Follow the instructions in "Installing a Network Using LocalTalk Cables" in 
LocalTalk Cable System Owner's Guide to connect your LaserWriter to your 
Macintosh computer. 
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These instructions describe how to connect the boxes and cables together, and then 
connect one of the connector box cables to the LaserWriter and one to the 
Macintosh. The result is shown in Figure 3-1. 

• Note: If you have a LaserWriter lINT or NTX, your LaserWriter owner's guide has 
instructions on connecting the printer by using AppleTalk cables and 
connectors. You can follow the instructions in your owner's guide instead of in 
the LacalTalk Cable System Owner's Guide. 

• Figure 3-1 LocalTalk cables and connector boxes connecting a LaserWriter 
to a Macintosh 

LaserWriter II Macintosh II 

• Note: The SCSI port on the LaserWriter II NTX lets you connect a hard disk 
directly to this printer to provide a place to store large numbers of fonts that are 
quickly accessible to the printer. Your LaserWriter owner's guide contains 
complete information on connecting a hard disk to the printer SCSI port. 

5. Switch on the printer and make sure the green Select light flashes. 

When you turn on the LaserWriter, it prints a test page if it's running correctly. Your 
LaserWriter owner's guide contains more information about this self-test. If the 
printer does not produce a test page, see the guide for help in correcting 
the problem. 

6. Switch on the Macintosh and start AlUX. 

7. Log in to the root account. 
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• Note: If any users on your system have already created personal System Folders 
(as described in AlUY" Essentials), they must also log in and go through the next 
four steps to update their personal System Folders with a printer selection. 

8. In the A!UX Finder, choose the Chooser from the Apple menu. 

9. Make sure the AppleTalk Active button is selected. 

Click the button if it isn't. 

10. Select the LaserWriter icon from the upper-left box. 

The name LaserWriter, or another name previously assigned to this printer, appears in 
the box to the right. 

11. Close the Chooser. 

You can close the Chooser by clicking its close box. Proceed to "Testing the Printer 
in A/UX" later in this chapter. 

Adding an ImageWriter 

You can use any of the ImageWriter printers with A/Ux. You can connect an ImageWriter either 
with two LocalTalk system connector kits or with a serial cable. You gain no advantage using 
one method over the other, with one exception: if you connect an ImageWriter LQ with a 
serial cable you will not be able to use Ipr, the A/UX print utility. 

D Important If you are connecting an ImageWriter I, you must use a 
serial cable. 0, 

This section describes how to 

• connect an ImageWriter to a Macintosh running A/UX by using either LocalTalk system 
cables or a serial cable 

• use the Chooser to select the printer you're going to use, if you connected the printer with 
LocalTalk system cables 
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Connecting an ImageWriter with LocalTalk cables 

You need to install a LocalTalk Card in your ImageWriter printer if you wish to connect it to 
your Macintosh with LocalTalk system cables. This card is available from your authorized 
Apple dealer. 

D Important If you have an ImageWriter I, you must connect it with a serial cable. 
Turn to "Connecting an ImageWriter With a Serial Cable" later in 
this chapter. 6 

When you are finished with the procedures in this section, you will have set up a small 
AppleTalk network between your Macintosh and your printer. Should you later wish to expand 
this network to include other computers or printers, refer to LoealTalk Cable System Owner)s 
Guide, which comes with each LocalTalk system connector kit, for further instructions. 

To use LocalTalk system cables to connect an ImageWriter to a Macintosh running A/UX, 
follow these steps: 

1. Shut down A/UX. 

Choose the Shut Down command from the Special menu. 

2. Unpack the ImageWriter, but don't turn the power on. 

Follow the instructions in your ImageWriter II or ImageWriter LQ owner's guide. 

3. Install a LocalTalk Card in the ImageWriter. 

To install the LocalTalk Card in your ImageWriter, follow the instructions in the 
ImageWriter II/LQ LoealTalk Option User)s Guide that comes with the LocalTalk Card. 

4. Follow the instructions in "Installing a Network Using LocalTalk Cables" in 
LocalTalk Cable System Owner's Guide to connect your ImageWriter to 
your Macintosh computer. 

These instructions describe how to connect the boxes and cables together, and then 
connect one of the connector box cables to the ImageWriter and one to the 
Macintosh. The result is shown in Figure 3-2. 
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• Figure 3-2 LocalTalk cables and connector boxes connecting an ImageWriter 
to a Macintosh 

ImageWriter II Macintosh II 

5. Switch on the printer and make sure the green Select light is on. 

6. Switch on the Macintosh and start A/UX. 

7. Log in to the root account. 

• Note: If any users on your system have already created personal System Folders 
(as described in AlUX Essentials), they must also log in and go through the next 
four steps to update their personal System Folders with a printer selection. 

S. In the A/UX Finder, choose the Chooser from the Apple menu. 

9. Make sure the AppleTalk Active radio button is selected. 

Click the button if it isn't. 

10. Select the AppleTalk ImageWriter icon or the LQ AppleTalk ImageWriter icon 
from the upper-left box. 

The name of your model of ImageWriter appears in the box to the right. 

11. Close the Chooser. 

You can close the Chooser by clicking its close box. Proceed to "Testing the Printer 
in A/UX" later in this chapter. 
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Connecting an ImageWriter with a serial cable 

You can connect any ImageWriter with a serial cable to a Macintosh computer running A/UX. 
However, if you connect an ImageWriter LQ with a serial cable, you will be able to print using 
Macintosh applications such as TextEditor, but you won't be able to print using lpr, the A/UX 
print utility. See "Printing a File" later in this chapter for more information. 

To add an ImageWriter by using a serial cable, follow these steps: 

1. Unpack the ImageWriter, but don't tum the power on. 

Follow the instructions in your ImageWriter owner's guide. 

2. Use the serial cable(s) appropriate for your printer, as described here. 

D For the ImageWriter II and ImageWriter LQ 

Use a Macintosh Plus-to-ImageWriter II cable, as explained in your owner's 
guide. Figure 3-3 shows the result. 

• Figure 3-3 A serial cable connecting an ImageWriter II to a Macintosh II 

ImageWriter II Macintosh II 

D For the ImageWriter I 

Connect a Macintosh Plus adapter cable to an ImageWriter cable. Attach the 
DB-9 connector of the ImageWriter cable to the DB-9 connector of the 
Macintosh Plus adapter cable. Then plug the DB-25 connector of the 
ImageWriter cable into the printer port on the ImageWriter. Finally, plug the 
mini-8 connector of the Macintosh Plus adapter cable into the printer port on 
the Macintosh computer. 
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3. Follow the instructions in your ImageWriter owner's guide to connect the 
serial cable between the printer port on the back of the computer and the 
serial port on your printer. 

4. Switch on the printer and make sure the green Select light is on. 

5. Switch on the Macintosh and start A/UX. 

Testing the printer in A/UX 

To be sure the printer is working in A/UX, follow these steps: 

1. Choose CommandShell from the Apple menu. 

If a CommandShell window does not appear, choose New from the File menu. 

2. Open a letter stored in the start account by entering 
TextEditor /users/start/letterl 

This starts the TextEditor application and automatically opens the file 1 e t t e r 1 , 

which contains a bland business letter. 

3. Choose Print Window from the File menu. 

4. Click OK in the Print dialog box. 

This sends the letter to the printer. 

If the letter isn't printed, there could be a problem with the printer. See the 
troubleshooting section in your printer owner's guide for help locating the problem. 
If the problem isn't solved with help from the owner's guide, the problem might be 
with A/UX. See "Managing Other Peripheral Devices" in AlUX Local System 
Administration for information on checking that the printer spooler and printing 
scheduler are running. 

You are finished connecting and testing the printer. You can quit the TextEditor 
application by choosing Quit from the File menu. The next section provides 
instructions on two ways to print a file in A/UX. 
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Printing a rue 
This section describes the two main ways to print files in A/UX. First it describes how to print 
the Macintosh way by selecting Print from the File menu. Then it describes how to print using 
Ipr, the A/UX print utility. (A/UX also supplies several standard UNIX text processors, such as 
troff and tbl. See AlUX Text Processing Tools for information on creating and printing files 
with these utilities.) 

The files that you can print the Macintosh way include those created with Macintosh 
applications as well as ordinary text files. Macintosh applications make use of the Macintosh 
graphic user interface. An example of this kind of application is TextEditor, which is 
distributed with A/UX as its default text editor. TextEditor gives you the capability to create, 
edit, and print text files with the help of a mouse and pull down menus. 

The files you can print with the AlUX print utility, Ipr, are files created with A/UX text 
editors, such as TextEditor and the vi editor, and text files that are part of the A/UX 
distribution; for example, /etc/passwd. 

Printing a rue the Macintosh way 

Follow these steps to use the Macintosh way to print a text file or a file created with a 
Macintosh application: 

1. Select the fue you want to print from the AlUX Finder. 

2. Choose Print from the File menu. 

This automatically starts the application that created the file and opens the file on 
your screen. A Print dialog box will also appear. With TextEditor as the default 
editor under A/UX, you can select text files such as / etc / pas s wd and send them to 
the printer in this way. 

3. Click OK in the Print dialog box. 

This sends the file to your printer. 
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Alternatively, if you have your application already running, you can open the file from your 
application and then choose Print from the application's File menu. Again, click OK when the 
Print dialog box appears. 

Printing a text ftIe by using the A/UX 1 P r print utility 

Follow one of these steps to print a file by using the 1 p r utility: 

• If you have a LaserWriter or a LocalTalk-connected ImageWriter printer, 
enter the following command from a CommandShell window: 
Ipr filename 

For filename, type the name of the text file you want to print. 

• If you have a serially connected ImageWriter printer, enter the following 
command from a CommandShell window: 
Ipr -Piw filename 

For filename, type the name of the text file you want to print. 
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Chapter 4 Adding and Managing Hard Disk SCs 

You can expand your A/UX system by adding one or more external hard 
disks. Multiple hard disks provide not only more storage, but also more 
ways to divide up disk space. For example, some people will use A/UX 
exclusively, while others might distribute their time or their co-worker's 
time between A/UX and the Macintosh Operating System (OS). Perhaps 
they will want half of their added disk space allocated for A/UX and half for 
the Macintosh OS. 

Since A/UX can access files in the portion of the disk storing the 
Macintosh OS as easily as it can access files in its own file system, consider 
storing all your Macintosh applications and documents in a Macintosh file 
system so that you can access them from either operating system. 

This chapter describes how to 

• devise a plan to allocate disk space for A/UX and the Macintosh OS 

• prepare a disk to store only A/UX user files 

• prepare a disk to store both A/UX and the Macintosh OS 

• prepare a disk with a separate / u s r partition to store large 
application programs such as X Window System 

• create a file system on an A/UX partition and mount it into A/UX 
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Planning the use of your disk space 

There's no substitute for a good plan when it comes to making efficient use of hard disks. 
Before partitioning your disk, you need to answer several questions: 

• What's your total disk capacity? Of course, the larger the available disk space, the more 
flexibility you have in designing your system. 

• How much disk space do you require for user accounts? This will help you decide how much 
disk space you need to add and which distribution files you'll choose not to install, such as 
the on-line man (manual) pages. 

• How much space do you require for large application programs you might add, such as X 
Window System? If you are planning to add X Window System, keep in mind that XII 
requires 13 megabytes (MB) of disk space and MacX™ requires 4 MB of disk space. When 
calculating the required partition size for XII or MacX, increase your figure by 10% to allow 
space for the file system to juggle its overhead work. 

• Do you need to use the Macintosh OS? If so, you'll probably want to increase the size of 
the MacPartition because, as shipped, it is 1 MB in size and likely to be inadequate. 

• Are there distribution files that you didn't install due to limited disk space, such as the 
on-line man pages? If so, you might want to install them now that you are adding 
disk space. 

When calculating the required partition size for any partition, increase your figure by at least 
10% to allow space for the file system to juggle its overhead work. 

Understanding a few facts 

Novice A/UX administrators are often confused by the difference between a partition and a 
file system. Understanding the difference between these two entities helps when performing 
the steps to create them. 

• A partition is hardware oriented. It is a sectioned-off area of a disk. You create disk 
partitions by using the Apple HD SC Setup software. (You can also create partitions by 
using the dp (lM) utility provided with AlUX. But be forewarned: using this utility requires 
a solid understanding of UNIX file systems and slice numbers.) 
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• A file system is software oriented and goes into a partition. A file system provides the 
overhead or "bookkeeping" system on a disk to manage the location of files. A/UX 2.0 uses 
the Berkeley type of file system. When you add a file system to A/UX, you have a choice 
between using two types: Berkeley and System V. Unless you have a reason to do 
otherwise, we recommend you stay with the Berkeley file system, as it offers better 
performance and allows longer filenames. 

• A/UX and the Macintosh OS use entirely different types of file systems. One of the major 
differences between the two operating systems is that the Macintosh OS and related files 
always reside in one partition, whereas A/UX can reside in several partitions, each one with 
a special use. 

• With Apple HD SC Setup you can choose from several predefined partitioning schemes. 
These schemes provide various combinations of partitions for A/UX system files, A/UX user 
files, and the Macintosh OS. With Apple HD SC Setup you can customize any of these 
predefined partitioning schemes to further match your needs. 

• Some of the predefined partitioning schemes are applicable only to disks of a certain size. 
The Apple HD SC Setup software displays a help box on the screen to give you this type of 
information when selecting partitioning schemes. 

Keeping user flIes in a separate partition 

User files are any files on an A/UX system other than those distributed with A/UX. Typical user 
files are programs you've written, files created with text editors, and application programs 
you run in A/UX. These are normally stored in the directories associated with user accounts. 

Over time, the number of user files increases, while the number of distribution files remains 
constant. Therefore, when you add disk space to your A/UX system, you're adding it to hold 
user files. (The exception to this is adding disk space to hold distribution files that you never 
installed because of limited disk space.) 

As distributed, A/UX stores user accounts in a partition with system files. When you disperse 
A/UX over multiple disks, put the user files in a separate partition from the distribution files. 
This will let you manage the process of backups with less time and necessary disk space. It will 
let you concentrate on backing up the partition that contains the user files, which change 
frequently and thus need backing up frequently, and not the partition containing the system 
files, which seldom change and thus seldom need backing up. 
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Keeping the user files separate from the distribution files means putting user files in their own 
partition so you can mount their file system in their own directory, or limb, off of root, as 
shown in Figure 4-1. 

• Figure 4-1 User files on a major limb off of root 

The predefined partitioning schemes in HD SC Setup are designed to place user files in a 
separate partition from distribution files. 

Novice administrators often make the mistake of creating user accounts on the /usr branch. 
This is not a good idea because / u s r is one of the largest branches in the A/UX file system and 
contains on-line man (manual) pages, utilities, games, and many other files. Putting user 
accounts here would make backing up the user account files very difficult. Instead, use the 
/usr branch to store large application programs you may add to A/UX, such as X Window 
System. And to store user accounts, use the / use r s directory, as described in this chapter, or 
another directory that you create. 

Only you, the administrator, will know that user files are actually stored on a separate disk, in a 
separate file system off of root. No disk icon for the users file system will appear on the 
desktop to give it away as something special. Users will see their user accounts as residing in a 
directory under /, like any other directory. 
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Connecting the Hard Disk SC 

Your Apple Hard Disk SC owner's guide describes how to attach a second SCSI disk to your 
computer, or a third or fourth. It also describes the intricacies of attaching an additional hard 
disk to a system for which a Tape Backup 40SC or an AppleCD SC drive is already connected. 
See the Apple Hard Disk SC owner's guide for instructions on physically connecting an additional 
Hard Disk SC, then return to "Starting Apple HD SC Setup," the next section in this chapter. 

Starting Apple HD SC Setup 

Here are the steps to prepare a disk. They apply to both new and used disks. 

1. Turn on the power to all external disks, including the one you want 
to partition. 

2. Start the computer from the Utilities 1 floppy disk included with the 
A/UX product. 

With the computer turned off, insert the Utilities 1 disk into the drive and press the 
POWER ON key. 

Apple HD SC Setup runs on the Macintosh as and not on AlUX. The floppy disk 
contains a Macintosh System Folder with all the necessary system files to start up the 
Macintosh as. 

3. Double-click the Apple HD SC Setup icon to start this program. 

The main dialog box of Apple HD SC Setup appears, as shown in Figure 4-2. 

• Warning Apple HD SC Setup is preset to initialize the disk with the lowest 
SCSI ID number. Do not initialize your system disk because 
initializing erases the disk. ~ 
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• Figure 4-2 The main dialog box of Apple HD SC Setup 

Apple HD SC Setup u2.0.1 a3 

( Initialize) 

( UPdate) 

( partition) 

( Test) 

K Quit D 

SCS I Deuice: 5 

Driue 

~ The uolume name is My 
~ Macintosh 

Do I need to initialize? 

You only need to initialize a Hard Disk SC if 

• the disk is blank and has not been used. 

• the disk has been previously used with an operating system other than A/UX. 

• you've been trying to use the disk with A/UX, but it's been giving you trouble. 

To use the disk for A/UX, start the disk preparation procedure from scratch so that by the 
end of this procedure either the disk will function properly or you'll know that the problem 
lies with the disk and not with the software. 

• Note: If your disk contains files, make a backup of the important files on the disk 
before reinitializing, as reinitializing erases the disk. 

If you need to initialize the disk, follow these steps. Otherwise, turn to the next section, 
"Partitioning the Disk." 
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1. Click Drive until you see the SCSI number of the disk you want to initialize. 

The SCSI ID number is located on the back panel of the hard disk, in a small opening 
below the SCSI ports. 

2. Click Initialize. 

An alert box tells you that initializing erases all information from the disk. 

3. Click Init. 

If the disk has not been previously partitioned with a Macintosh partition, you are 
prompted to name the Macintosh volume. The initialization procedure 
automatically partitions the disk with one large Macintosh volume. 

4. If you are prompted to name the Macintosh volume, type a name and 
click OK. 

Volume is another word for file system. If you create a Macintosh partition on the 
disk, the name you supply will appear in the Finder to identify the Macintosh 
file system. 

Disk initialization takes several minutes, depending on the size of the disk. 

You're ready to partition the disk. 

Partitioning the disk 

Use this list to decide which of the next three subsections describes the partitioning scheme 
you want, then follow the procedure provided in that subsection. 

• To partition for A/UX user files exclusively, see "Creating a Partition for A/UX User Files 
Only." You must have a 20 MB disk or larger. 

• To partition for A/UX user files and the Macintosh OS, see "Creating Partitions for A/UX 
User Files and the Macintosh OS." You must have a 40 MB disk or larger. 

• To partition for A/UX user files and a / u s r partition to store large application programs 
such as X Window System, see "Creating Partitions for A/UX User Files and / u sr." You must 
have an 80 MB disk or larger. 
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Other partitioning schemes are possible, as well as variations on the ones listed here. For help 
in carrying out variations, see the complete reference for A/UX and Apple HD SC Setup in 
A!UX Local System Administration. 

The partitioning schemes described here assume that the A/UX system is already on a hard 
disk. If you need instructions to install the A!UX system from tape, floppy disks, or a 
CD-ROM, whether it be a repeat installation or your first installation of A/UX, see 
A!UX Installation Guide for instructions. 

Creating a partition for A/UX user ftles only 

Follow these steps if you want to prepare a disk to hold A/UX user files, to the exclusion of 
A/UX system files and the Macintosh as. 
1. Start the Apple HD SC Setup program. 

Follow the instructions in "Starting Apple HD SC Setup," earlier in this chapter. 

6 Important Make sure you are partitioning the correct disk. Does the SCSI 
device number displayed on screen match the SCSI ID number of 
the hard disk you want to partition? If not, click Drive until 
they match. D. 

2. Click Partition. 

The Partition dialog box appears, as shown in Figure 4-3. 
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• Figure 4-3 The Partition dialog box 

Select a predefined disk partitioning scheme and click OK to partition 
the entire disk. Or select Custom to make your own partitions. 

MaHimum Macintosh 

(Custom) 

( OK 

K Cancel D 

3. Select Maximum Free A!UX. 

A brief description of this partitioning scheme appears in the dialog box. 

4. Click OK to conf1t1ll your selection. 

You can also double-click the partition to select and confirm it. 

An alert box warns you that partitioning erases any information on your hard disk. If 
you click Cancel, you return to the main dialog box, and no partitioning takes place. 

5. Click OK to continue. 

Partitioning usually takes less than a minute. 

You return to the main dialog box. 

6. To see a graphic representation of your newly partitioned disk, click 
Partition, and then click Custom. 

The Custom Partition dialog box appears, as shown in Figure 4-4. 

Chapter 4 Adding and Managing Hard Disk SCs 4-9 
030-0760-A 



• Figure 4-4 The Custom Partition dialog box for Maximum Free A/UX 
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Partitions 
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( Done J 

The disk is divided into three partitions, with the largest partition for A/UX user 
files. The MacDriver partition contains disk-management software. The grey 
rectangle is free space at the end of the disk. The size of each partition, in 
kilobytes, is shown to the left of the rectangle that represents the partition . 

.. Warning 

7. Click Done. 

The MacDriver partition and the free space at the end of the disk 
are necessary for proper use of the disk. Do not remove them. ... 

You return to the main dialog box. 

8. Click Quit. 

An icon for your newly partitioned A/UX disk will not appear in the Macintosh Finder 
or in the A/UX Finder. 
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You are ready for the last two procedures in preparing a disk for A/UX: making a file 
system and mounting it onto your existing A/UX system. Turn to "Making and 
Mounting a File System," later in this chapter. 

Creating partitions for A/UX user flIes and the Macintosh OS 

Yau can partition an additional hard disk to store A/UX user files and the Macintosh as. The 
predefined partitioning scheme automatically divides the disk 50/50 between these two uses, 
but you can easily change the size of these two partitions. 

1. Start the Apple HD SC Setup program. 

Follow the instructions in "Starting Apple HD SC Setup," earlier in this chapter. 

6 Important Make sure you are partitioning the correct disk. Does the SCSI 
device number displayed on screen match the SCSI ID number of 
the hard disk you want to partition? If not, click Drive until 
they match. D 

2. Click Partition. 

The Partition dialog box appears, as shown in Figure 4-5. 
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• Figure 4-5 The Partition dialog box 

Select a predefined disk partitioning scheme and click OK to partition 
the entire disk. Or select Custom to make your own partitions. 

MaHimum Macintosh ~ 
Minimum Macintosh ~ My Macintosh 

~~i~7~;;~~iE;~:~~~:i~~:::UH I (custom) 

MaHimum Free A/U" 10 

K Cancel D 

3. Press the down scroll arrow until you see 500/0 Macintosh, 500/0 A/UX, and 
then select it. 

A brief description of this partitioning scheme appears in the dialog box. 

4. Click OK to confmn your selection. 

You can also double-click the name of the partitioning scheme to select and 
confirm it. 

An alert box warns you that partitioning erases any information on your hard disk. If 
you click Cancel, you return to the main dialog box, and no partitioning takes place. 

5. Click OK to continue. 

If the disk has not been partitioned with a Macintosh partition before, you are 
prompted to name the volume. 
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6. If a message prompts you to name the Macintosh volume, type a name and 
click OK. 

Volume is another word for file system. The name you supply will appear in the 
Finder to identify the Macintosh file system. 

Partitioning usually takes less than a minute, depending on the size of the Macintosh 
partition. Then you return to the main dialog box. 

7. Click Partition, and then click Custom. 

The Custom Partition dialog box appears, as shown in Figure 4-6. 

• Figure 4-6 The Custom Partition dialog box for 50/50 
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( Group ) 
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n Done D 

The disk is divided into two main partitions of equal size: one for A/UX user files 
and one for the Macintosh as. The Macintosh partition has the name you gave it. 
The size of each partition, in kilobytes, is shown to its left. 
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... Warning The MacDriver partition and the free space at the end of the disk 
are necessary for proper use of the disk. Do not remove them. • 

If the 50% Macintosh, 50% AIUX partitioning scheme fits your needs, you are 
finished partitioning and ready to turn to "Making and Mounting a File System," later 
in this chapter. 

However, if you want to change the sizes of these two partitions, turn to "Adjusting 
the Size of Partitions," later in this chapter. 

Creating partitions for user rues and / u s r 

As shipped, the A/UX root partition contains a large directory called /usr. This directory 
traditionally stores large application programs that you might want to add to the system. The 
XII product is an example of a large application program that you would store in / us r. 

To allow room for a large application program, such as the XII product, partition your disk 
with a separate / u s r partition by following this procedure. 

• Note: If you are planning to add X Window System to the / u s r partition, keep in 
mind that XII requires 13 MB of disk space and MacX requires 4 MB of disk space. 
When calculating the required partition size for XII or MacX, (or for any partition), 
increase your figure by 10% to allow space for the file system to juggle its 
overhead work. 

1. Start the Apple HD SC Setup program. 

Follow the instructions in "Starting Apple HD SC Setup," earlier in this chapter. 

6 Important Make sure you are partitioning the correct disk. Does the SCSI 
device number displayed on screen match the SCSI ID number of 
the hard disk you want to partition? If not, click Drive until they 
match. 6 
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2. Click Partition. 

The Partition dialog box appears, as shown in Figure 4-7. 

• Figure 4-7 The Partition dialog box 

Select a predefined disk partitioning scheme and click OK to partition 
the entire disk. Or select Custom to make your own partitions. 

(custom) 

OK 

(( Cancel J 

3. Press the down scroll arrow until you see 500/0 Macintosh, 500/0 Free AlUX, 
and then select it. 

The dialog box displays some information about this partitioning scheme. 

4. Click OK. 

You can also double-click the partition to select and confirm it. 

An alert box warns you that partitioning erases any information on your hard disk. If 
you click Cancel, you return to the main dialog box, and no partitioning takes place. 

5. Click OK to continue. 

If the disk has not been partitioned with a Macintosh partition before, you are 
prompted to name the Macintosh volume. 
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6. If you are prompted to name the Macintosh volume, type a name and 
click OK. 

Volume is another word for file system. The name you supply will appear in the 
Finder to identify the Macintosh file system. 

Partitioning usually takes less than a minute, depending on the size of the Macintosh 
partition. Then you return to the main dialog box. 

7. Click Partition, and then click Custom. 

The Custom Partition dialog box appears, as shown in Figure 4-8. 

Each partition is represented by a rectangle, and its size, in kilobytes, is shown to 
the left of the rectangle. Now you must remove the Macintosh partition and replace 
it with a partition for / u sr. 

• Figure 4-8 The Custom Partition dialog box for 50/50 
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8. Click the Macintosh partition to select it. 

Figure 4-9 shows the partition after you've selected it. 

• Figure 4-9 Selecting the Macintosh partition for removal 
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~ Done J 

A warning message asks you to confirm that you want to erase the information in 
the partition. 

10. Click OK to continue. 

Free space replaces the removed partition, as shown in Figure 4-10. 
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• Figure 4-10 The free space after a Macintosh partition is removed 
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11. Press and drag downwards from the top of the grey area to select all the 
free space. 

As you drag, a rectangle indicates the selection, as shown in Figure 4-11. 

• Note: Leave 1K of free space at the end of the disk. The system needs this space 
as a buffer. And don't click the MacDriver partition or you'll move it instead of 
selecting the free space. 
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• Figure 4-11 Selecting the free space 
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After selecting the free space, the list of individual partition types appears, as shown 
in Figure 4-12. 
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• Figure 4-12 The list of individual partition types 

Macintosh Uolume 
Scratch 
R/UH Rutorecouery 
R/UH RootO'Usr slice 0 
R/UH Swap slice 1 
R/UH Root slice 0 
R/UH Usr slice 2 
Free R/UH slice 3 
Free R/UH slice 4 
Free R/UH slice 5 
Free R/UH slice 6 
Mise R/UH 

~ Select the type of partition 
and then adjust its size as 
needed. 

Minimum unknown 

139069 

MaHimum 39069 K 

( OK ) 

n Cancel D 

12. Click "A/UX Usr slice 2" to select it. 

To the right appears the proposed size, in kilobytes, for the new partition. In 
addition, the minimum and maximum sizes for this type of partition are displayed, 
as shown in Figure 4-13. In this case, the minimum size is 512K and the maximum size 
is your proposed size. 
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• Figure 4-13 Selecting the A/UX Usr slice 2 partition type 

Macintosh Uolume 
Scratch 
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R!UH Root&Usr slice 0 
R!UH Swap slice 1 
R!UH Root slice 0 
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13. Click OK. 

Select the type of partition 
and then adjust its size as 
needed. 

Minimum 512 K 

139068 

MaHimum 39068 K 

( OK ) 

K Cancel l 

The Custom Partition dialog box shows the new partitioning scheme, 

14. Click Done. 

You return to the main dialog box, 

15. Click Quit. 

• Note: This software program assigns slice 2 to the us r partition, You do not 
need to use pname to make this assignment. 

An icon for your newly partitioned A/UX disk will not appear in the Macintosh Finder or in the 
A/UX Finder. All A/UX partitions are subsumed in the I file system, so the I icon in the A/UX 
Finder represents all your A/UX partitions, 

You are ready to make and mount a file system on the partition, For instructions, turn to 
"Making and Mounting a File System" later in this chapter, However, if you want to adjust the 
size of partitions, continue with the next section "Adjusting the Size of Partitions," 
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Adjusting the size of partitions 

In the following steps, the figures illustrate a particular repartitioning scheme. But you can 
easily modify these steps to adjust the sizes of other partition types as well. 

1. Start the Apple HD SC Setup application. 

Follow the instructions in "Starting Apple HD SC Setup," earlier in this chapter. The 
main dialog box of Apple HD SC Setup appears, as shown in Figure 4-14. 

D Important Make sure you are partitioning the correct disk. Does the SCSI 
device number displayed on screen match the SCSI ID number of 
the hard disk you want to partition? If not, click Drive until 
they match. 6 

• Figure 4-14 The main dialog box of Apple HD SC Setup 
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2. Click Partition. 

The Partition dialog box appears, as shown in Figure 4-15. 
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• Figure 4-15 The Partition dialog box 
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the entire disk:. Or select Custom to mak:e your own partitions. 
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3. Click Custom. 

The Custom Partition dialog box appears, as shown in Figure 4-16. 
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• Figure 4-16 A Custom Partition dialog box 
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• Note: The contents of the dialog box vary depending on the partitioning scheme 
of your disk. 

4. Select the partition you want to reduce in size. 

5. Click Remove. 

This is temporary; you'll add the partition back in the next steps. 

An alert message warns that removing causes loss of all data on the partition. 

6. Click OK to continue. 

Free disk space replaces the removed partition, as shown in Figure 4-17. You need to 
specify the size of the partition you want to add back. 
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• Figure 4-17 Free space replacing the removed partition 
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7. Press and drag downwards from the top of the grey area, and release the 
mouse button when the partition is the approximate size you want. 

Figure 4-18 shows you part of the free space is selected. 
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• Figure 4-18 Selecting space for the new partition 
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• Note: Don't click on the MacDriver partition or you'll move this partition instead 
of selecting the free space. 

You don't have to be exact; you can enter the exact size in the next dialog box. 

The list of individual partition types appears, as shown in Figure 4-19. The size, in 
kilobytes, of the partition awaiting a type appears to the right under Minimum. You 
can type a number to enter an exact size for the partition. 
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• Figure 4-19 The list of individual partition types 
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8. Select the partition you want to add back. 

For example, if you removed the Macintosh partition, select Macintosh Volume. 

9. Click OK. 

You return to a graphic representation of your partitioning scheme, as shown in 
Figure 4-20. 
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• Figure 4-20 A reduced Macintosh partition 
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In the next step you'll remove the partition that you want to be the largest on the 
disk, for example Free A/UX slice 3, and then add it back, sized to fit the free space. 

10. Select the partition you want to enlarge. 

11. Click Remove. 

An alert message warns you that removing causing the loss of all data on 
the partition. 

12. Click OK to continue. 

Free space replaces the removed partition. Now you need to select the free space. 

13. Press and drag downwards from the top of the grey area to select the free 
space. 

Figure 4-21 shows the selected free space. 

Q Important Don't select all the free space. Leave 1K of the disk in free space. A 
file system requires lK of unallocated free space as a buffer. D, 
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• Figure 4-21 Selecting the free space 
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The list of individual partition types appears. 

14. Select the partition type you want to add back. 

For example, select Free A/UX slice 3. 

) 

) 

Notice the size, in kilobytes, is displayed to the right under Minimum. 

15. Click OK. 

The new partitioning scheme appears, as shown in Figure 4-22. 
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• Figure 4-22 The new partitioning scheme 
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16. Click Done. 

You return to the main dialog box. 

17. Click Quit. 

You are now ready for the last two procedures in preparing a disk for A/UX: putting a 
file system on it and mounting it into your existing A/UX system. Turn to "Making 
and Mounting a File System" to complete these procedures. 

Making and mounting a fde system 

A partitioned disk is physically ready to receive data. It lacks, however, the "bookkeeping 
system" necessary to manage it. A file system provides the bookkeeping system necessary to 
manage a disk and to locate files on it. 
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You create a file system by using the newfs command . 

• Note: newfs creates a BSD (Berkeley Software Distribution) file system, which is the 
type used by A/UX as shipped. A/UX also supports System V file systems. System V 
file systems are not recommended because they limit filenames to 14 characters. 
However, if you want to create System V file systems, use the mk f s command 
instead of newfs. For details on mkfs, see mkfs(1M) in A!UX System 
Administrator's Reference, or enter man mk f s in a CommandShell window to see the 
same information on the screen. 

Making a ftle system 

If your disk contains more than two A/UX partitions you'll need to run newfs for 
each partition. 

1. Start up AlUX and log in to the root account to become the superuser. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. To display a CommandS hell window, choose CommandShell from the 
Apple menu. 

3. Type newfs and press COMMAND-K. 

The newfs Commando dialog box appears, as shown in Figure 4-23. 
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• Figure 4-23 The newfs Commando dialog box 
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4. In the area labeled "Disk type" click the code name that describes the type 
and size of your disk. 

Your choices for code names are: 

Type of Disk Code Name 

160MB disk HD160SC 

80MB disk HD80SC 

40MB disk HD40SC 

20MB disk HD20SC 

1440K floppy disk 1440K Floppy disk 

800K floppy disk 800K Floppy disk 
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The Specify radio button applies to all disk not listed. If your disk does not match 
any of these, see the documentation for your hard disk for information on 
specifying to A/UX the type and size of the disk. A/UX stores these code names in 
the /etc/disktab file. Add the code name for your disk to this file. Then display 
the newf s Commando dialog box again, choose Specify, and enter the code name 
in the "Disk type" text box. 

5. To specify the device to mount, click "Choose device rue." 

When specifying the device name for a hard disk, you begin with the prefix 
/ de v / d s k /. In the next three steps you specify this prefix. 

6. If you need to trace your way back to the / directory, press on the current 
directory name displayed at the top of the dialog box and drag to select /. 

The contents of the / directory are displayed. 

7. To open the dey folder, double-click it. 

8. To open the dsk folder, double-click it. 

What you see is a list of the possible extensions to the device name / dev / dsk. You 
need to scroll down and find the one that describes your partition. 

9. Double-click the name that describes your partition. 

The extension to a device name is given in the form of cndOsx , where n is the SCSI 
ID number for the disk and x is the slice number for the partition. 

For example, if your disk is SCSI ID 4 and your partition is slice 3 (the Free A/UX slice 
3 partition for user files), you need to select c 4 dO s 3. If your disk is SCSI ID 5 and 
your partition is slice 2 (the partition for / u s r), the device name of your disk 
is cSdO s2. 

After selecting a name, you return to the newfs Commando dialog box. The full 
device name you specified shows in the Command Line box. 

10. Click newfs. 

You return to the CommandShell window. 

11. Press RETIJRN to run the command. 

The CommandS hell window shows information about the file system (ignore the 
warning that appears) and then displays the command-line prompt. 
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You need to create a file system for each A/UX partition on a disk. (Don't create a file system 
for a Macintosh partition.) Therefore, if your disk contains more than one partition, you need 
to repeat steps 2 through 11 for each additional partition. When repeating these steps to 
create a file system for another partition on the same disk, only the slice number changes. The 
slice numbers is what allows A/UX to distinguish between multiple partitions on a disk. 

Once you've created a file system for each partition on the disk, you are ready to mount the 
file systems. Instructions are provided in "Mounting a File System." 

For complete information on the newfs command, see newfs(1M) in A!UX System 
Administrator's Reference, or enter man newfs in a CommandShell window to see the same 
information on the screen. 

Mounting a ftle system 

Mounting a file system "hooks" it into the A/UX tree structure. A/UX cannot recognize a file 
system until it is mounted. 

Mounting can be done in two ways. You can mount a file system permanently, for access to thE 
files on the disk every time you start up A/UX, or you can mount it temporarily, for access until 
you next shut down A/UX. Mounting a file system permanently is more common than mounting 
temporarily, so that is what the procedures here show you. For more information on mounting 
a file system temporarily, see mount(1M) in A!UX System Administrator's Reference or enter 
man mount in a CommandShell window to see the same information on the screen. 

In the final steps of the following procedures you mount the file system with the fsentry 
script. For those users interested, the f s en try script makes an entry for a file system in the 
/ et c / f st ab file. (The filename is short for file system table.) An entry in this file is a file 
system's passport to being mounted each time A/UX starts up. The /etc/fstab file is one of 
the files A/UX reads as it starts up in order to receive instructions on how to configure itself. 
This file instructs A/UX as to which file systems to mount. 
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Mounting a file system at an existing directory 

Follow these steps if your purpose in mounting the file system is to replace an existing 
directory. For example, follow these steps if the new file system will replace the existing 
/users or /usr directory. 

However, don't follow these steps if your purpose with the new file system is to complement 
an existing directory. For example, don't follow these steps if you are mounting a file system 
to add space for user files and you want to keep your existing / use r s directory intact. You 
need to turn to "Mounting a File System at a New Directory," at the end of this chapter. 

Mount at /mn t to copy the files in your existing directory 

The / mn t directory is shipped with A/UX as a convenient, temporary place to mount a file 
system. In the following procedure you temporarily mount the new file system at / mn t. Then 
you copy into it the contents of the directory being replaced. 

1. Choose CommandShell from the Apple menu if a CommandS hell window 
isn't already displayed. 

2. Enter mount and press COMMAND-K. 

The mount Commando dialog box appears, as shown in Figure 4-24. 
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• Figure 4-24 The mount Commando dialog box 
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3. From the Operation options, select "Mount specified ftlesystem." 

4. Click in the "Specify ftle system to mount" text box. 

5. Type the device name that describes your partition. 

You must type the name in the form of /dev/dsk/cndosx! where n is the SCSI ID 
number of the disk, and x is the slice number containing the file system you want 
to mount. 

For example, if the disk is SCSI ID 5 and the partition is slice 3, type 
/dev/dsk/c5dOs3 

6. Click "Choose mount point." 

7. Click /mnt to select it. Do not double-click it. 

8. Click Directory. 

If you need to trace your way back to the Idirectory, press on the current directory 
name displayed at the top of the dialog box and drag to select /. The contents of the 
I directory are displayed. 
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9. Click mount. 

10. Press RETURN to run the command. 

You return to the command-line prompt, and the new file system is now mounted. 

Copy the directory to be replaced 

In this procedure you copy the contents of the directory being replaced before removing it. 
For example, if you are replacing the lusers file system, you copy the contents of lusers 

into Imnt. 

1. Choose CommandShell from the Apple menu if a CommandShell window 
isn't already displayed. 

2. Move to the directory that you want to copy by entering 
cd directoryname 

For example, to move to the lusers directory, enter cd /users. 

3. To copy the contents of this directory to the /mnt directory, enter 
find . -depth -print I cpio -pdl /mnt 

Be sure to enter this command exactly as shown. If you unintentionally run an 
incorrect command, stop the command from running by pressing CONTROL-C. 

Un mount the file system from /mnt 

In this procedure you disconnect the new file system from its temporary mount point. 

1. Choose CommandShell from the Apple menu if a CommandS hell window 
isn't already displayed. 

You need to be in the root directory to unmount a device from / mn t . 

2. To move to the root directory, enter cd / 

3. Enter umount /mnt 

• Note: The command is spelled umount and not unmount as you might expect. 

The file system is unmounted. 

Chapter 4 Adding and Managing Hard Disk SCs 4-37 
030-0760-A 



Remove the contents of the old directory 

In this procedure you remove the directory being replaced. 

1. Choose CommandShell from the Apple menu if a CommandShell window 
isn't already displayed. 

2. To remove the contents of the directory you are replacing, enter 
rm - r directoryname 

where directoryname is the name of the directory to be replaced. For example, if you 
are replacing the /users directory, you'd enter rm -r /users. 

Recreate the directory 

When you removed the directory in the previous procedure, the directory was removed along 
with its contents. In this procedure you recreate the directory so you can mount the new file 
system on it. 

1. Choose CommandShell from the Apple menu if a CommandShell window 
isn't already displayed. 

2. Enter mkdir directoryname 

where directoryname is the directory you removed in the previous procedure, for 
example, enter mkdir /users. 

Mount the file system permanently with fsentry 

In this, the final procedure to make and mount a file system, you mount the new file system 
permanently by using the fsentry script. The fsentry script configures A/UX to mount the 
new file system each time A/UX starts up. 

1. Choose CommandS hell from the Apple menu if a CommandS hell window 
isn't already displayed. 

2. Type fsentry and press COMMAND-K. 

The fsentry Commando dialog box appears, as shown in Figure 4-25. 
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• Figure 4-25 The fsentry Commando dialog box 
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3. To identify the disk you want to mount, click "Choose device fue." 

A dialog box displays the names of the files and folders in /. As when you created the 
file system, you need to select the filename that describes your file system. The 
filename is in the form of /dev/dsk/cndOsX, where n is the SCSI ID number for 
the disk and x is the slice number for the partition. 

4. Double-click dev to open the dev folder. 

5. Double-click dsk to open the dsk folder. 

6. Scroll to the ftlename that describes your newly created fue system. 

The filename is in the form of /dev/dsk/cndOsX, where n is the SCSI ID number 
for the disk and x is the slice number for the partition. 

For example, if your disk is SCSI ID 5 and slice 3 (a partition for user files), the 
device name of your disk is c 5 dO s 3. And if your disk is SCSI ID 4 and slice 2 (a 
partition for / u s r), the device name of your disk is c 4 dO s 2 . 
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7. Double-click the ftlename that describes your newly created ftle system. 

The filename is selected, and you return to the main dialog box of f sen try. 

8. To choose the directory to serve as the permanent mount point, click 
"Choose mount point." 

A dialog box displays the names of the files and folders in / dev / dsk. 

Use the following table to determine the directory at which to mount your 
file system. 

Type of partition 

Slice 3, 4, 5, or 6 for A/UX User files 
Slice 2 for /usr 

Mount point 

/users or /user 

/usr 

• Note: Macintosh partitions do not require mounting because they are not part of 
the A/UX file system. 

9. To move to the mount-point directory, press and drag on dsk and select I. 

10. To select the mount-point directory, press the down scroll arrow and select 
the directory name. 

For example, click /usr. 

Do not double-click the directory, or it displays its subdirectories rather than 
becoming selected. 

11. Click Directory. 

You return to the main dialog box of fsentry and are ready to run the command as 
it appears in the Command Line box. 

12. Click fsentry. 

13. Press RETURN. 

The command is run. The files on this partition will be accessible from the mount 
point directory the next time you start up A/UX and for each time after that. 
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14. Repeat steps 2 through 13 to run fsentry for any other partitions on 
the disk. 

A/UX uses slice numbers to distinguish between multiple partitions on a disk; only 
the slice number will change when you repeat the steps for another partition. 

For complete information on the fsentry command, see fsentry(1M) in A!UX System 
Administrator's Reference, or enter man fsentry in a CommandShell window to see the same 
information on the screen. 

Mounting a ftle system at a new directory 

Mounting a file system at a new directory eliminates many of the procedures required when 
mounting a file system at an existing directory. The following procedures are all that 
is required. 

1. Choose CommandShell from the Apple menu if a CommandS hell window 
isn't already displayed. 

2. Enter mkdir directoryname 

where directoryname is the name of the new directory at which to mount the file 
system. For example, if you are adding a second file system for user files, you might 
enter the following command to create the directory / use r s 1. 
mkdir /users1 

Your new directory is created. Now you can mount the new file system at this 
directory. 

You mount a file system permanently by using the fsentry script. The fsentry 
script configures A/UX to mount the new file system each time A/UX starts up. 

3. Type fsentry and press COMMAND-K. 

The fsentry dialog box appears, as shown in Figure 4-26. 
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• Figure 4-26 The fsentry Commando dialog box 
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4. To identify the disk you want to mount, click "Choose device HIe." 

A dialog box displays the names of the files and folders in /. As when you created the 
file system, you need to select the filename that describes your file system. The 
filename is in the form of /dev/dsk/cndOsX, where n is the SCSI ID number for 
the disk and x is the slice number for the partition. 

5. Double-click dev to open the dev folder. 

6. Double-click dsk to open the dsk folder. 

7. Scroll to the fdename that describes your newly created fde system. 

For example, if your disk is SCSI ID 5 and slice 3 (a partition for user files) the device 
name of your disk is cSdOs3. 

8. Double-click the fdename that describes your newly created fde system. 

The filename is selected and you are returned to the main dialog box of fsentry. 
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9. To choose the directory you created as the permanent mount point, click 
"Choose mount point." 

A dialog box displays the names of the files and folders in / dev / dsk. 

10. To move to the new directory, press and drag on dsk and select f. 

11. To select your new directory, press the down scroll arrow and select the 
directory name, for example /usersl. 

Do not double-click the directory, or it displays its subdirectories rather than 
becoming selected. 

12. Click Directory. 

You return to the main dialog box of fsentry and are ready to run the command as 
it appears in the Command Line box. 

13. Click fsentry. 

14. Press RETURN. 

The command is run. The files on this partition will be accessible from the mount 
point directory the next time you start up A/UX and for each time after that. 

15. Repeat steps 2 through 14 to run fsentry for any other partitions on 
the disk. 

A/UX uses slice numbers to distinguish between multiple partitions on a disk; only 
the slice number will change when you repeat the steps for another partition. 

For complete information on the fsentry command, see fsentry(1M) in A/UX System 
Administrator's Reference, or enter man fsentry in a CommandShell window to see the same 
information on the screen. 

Removing a Hard Disk SC from A/UX 

You can remove a Hard Disk SC to free the SCSI ID number for other uses. Removing a disk 
takes away access to all the files on it. 
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1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. In the Finder, double-click the / disk icon to open it. 

3. Double-click et c to open it. 

4. Double-click fstab to open it. 

5. Delete the ftle system entry for the disk. 

The entry in / etc / f stab for the file system looks similar to the following line: 
/dev/dsk/c4dOsO /users 4.2 rw 0 2 

• Note: If you plan to add the disk back to the system, instead of deleting the 
entry, at the beginning of the entry insert a pound sign ( #). The pound sign 
causes A/UX to ignore the line. When you next connect the disk, mount the file 
system using the mount command, then remove the pound sign from this line. 
The file system is entered in the file system table and A/UX will automatically 
mount it each time A/UX starts. 

6. Save the change and close the ftle. 

7. Click in the CommandS hell window to make it active. 

8. Shut down AlUX by choosing Shutdown from the Special menu. 

9. Disconnect the Hard Disk SC from your Macintosh computer. 

You need to have a SCSI terminator on the last device in your SCSI chain. If the Hard 
Disk SC was the last device on your SCSI chain, remember to move the terminator to 
the device that is now last on your SCSI chain. 

The disk is removed from A/UX. 
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Chapter 5 Adding and Managing the AppleCD SC 

The AppieCD SC peripheral device is extremely useful for accessing large 
amounts of information stored on CD-ROM discs. CD-ROM is an acronym 
for compact disc read-only memory. The information on a compact disc 
can be read but it cannot be added to or changed. A CD-ROM holds 500 
megabytes (MB) of data, supplying six times the storage capacity of a 
commonly used 80 MB hard disk. 

Though you cannot make changes to the information on a CD-ROM, you 
can read it, or you can copy its files to your hard disk and make changes to 
the information there. Because the CD-ROM is an excellent means for 
storing reference material or delivering large amounts of information or 
huge programs, more products and Macintosh related information are 
likely to be available on CD-ROMs in the near future. 

This chapter explains how to 

• install the AppleCD SC to use CD-ROM discs as a permanent source of 
reference information 

• install the AppleCD SC to use CD-ROM discs as a temporary source of 
reference information 

• open the files on a CD-ROM 

• copy the files from a CD-ROM to a hard disk 

• remove the AppleCD SC from an A/liX system 
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Setting up the AppieCD SC 

The following list describes the choices you have when setting up the AppieCD SC with a 
Macintosh running A/UX. Choose the setup you want and follow the instructions. 

• Note: A/UX does not support audio on a CD-ROM or support discs that use the High 
Sierra format. 

• If the AppieCD SC is set up and working with the Macintosh OS 

You do not need to modify the AppieCD SC resource file (device driver) that you've 
already installed in the Macintosh as. Turn to the section in this chapter that describes the 
set up you wish in A/UX, and follow the instructions. 

• If the AppieCD SC is not connected and set up and you want to use it with the 
Macintosh OS and A/UX 

Follow the instructions in AppleCD SC Owner's Guide to connect it to your Macintosh and 
install its resource file (device driver) in the Macintosh as. Then turn to the section in this 
chapter that describes the setup you wish and follow the instructions. 

• If the AppieCD SC is not connected and set up and you want to use it with 
A/UX only 

Follow the instructions in AppleCD SC Owner's Guide to connect it to your Macintosh by 
using the cables and power cord, but skip the steps to install the resource file (device 
driver). Then turn to the section in this chapter that describes the setup you wish to use 
with A/UX, and follow the instructions. 

Installing permanently 

You use the fsentry script to make the file systems on the CD-ROM accessible whenever 
A/UX is in use. You can then read the files on the CD-ROM the same way you would read files on 
a hard disk. 
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• Figure 5-1 A CD-ROM installed permanently 

The following procedure describes how to install the AppieCD SC so the files on a CD-ROM are 
readable whenever A/UX is in use. These steps take you through using the fsentry script, 
which makes an entry for the CD-ROM in the filesystem table / et c / f stab. This file contains 
a list of all the file systems that A/UX automatically mounts each time it starts up. 

If you only want to access the CD-ROM temporarily, such as to copy its files to a hard disk, 
then mount it when you need it rather than mounting it permanently. Turn to the next section, 
"Installing Temporarily," for instructions. 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandShell from the Apple menu. 

If a CommandShell window is not displayed, choose New from the File menu. 

3. Enter mkdir / cdrom 

This command makes a directory called cdrom. In the next steps, you will mount the 
CD-ROM at this directory. 

4. Type fsentry and press COMMAND-K. 

The fsentry Commando dialog box appears, as shown in Figure 5-2. 
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• Figure 5-2 The fsentry Commando dialog box 

r-fsentry Options---------------------. 
r· Local File System ············································1 c··File system type .............................................. ; 

! [ Choose delJice file ) I ~ @ 4.2 BSn ~ 
L. ....................................................................................................... ! ! 0 Sys t emU ! 
,···Remote File System .................................... ; ! 0 NFS i 
. : t ......................................................................................................... 1 

I t~!~'~:~~~:'~:::""::::_":::::"":"""J : Choo.e mount point 

1 fhmo1 (~ d~n~~ tlH"q: 1 D Specify mounting options 

i~""~"":";;";::~;::~"";"":;";;;;;;;;;::":~:~"Jj (M" "" W".l "i> U on s ) ( More op tio n. ) 

~command Line 
Lse-ntry -t 4.:;:j 

r-Help -------------------.1 [ Cancel ere-ate- a file- sy ste-m tab Ie- e-ntry. NOTE: This command may be- use-d by a e!i!!!.!!!!i!!!.!!!!i!!!.!!!!i!!!.!!!!i!!!.!!!~ 

supe-ruse-r only. n~iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii;;iiiiiiiiJ _ fsentry "" 

The file system type is preset to 4.2 BSD, with which A/UX is shipped. Use this file 
system type unless you know you need to use the NFS or System V type of file 
system. If you need to use one of these types of file systems, click "System V" or 
click "NFS" as the option for "File System type." 

5. Click "Specify mounting options." 

6. Click "Mounting options" and then click Read-only. 

You must mount the CD-ROM with read-only access because you cannot write to 
a CD-ROM. 

7. Click Continue. 

Now you need to specify the device name for the CD-ROM. 

8. Click "Choose device rue" to enter the name of the device to mount. 

The device name for a CD-ROM begins with dev / dsk, so this is what you need 
to specify. 
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9. To trace your way back to the /directory, press on the current directory 
name displayed at the top of the dialog box and drag to select /. 

The contents of the / folder are displayed. 

10. Double-click dey to open it. 

You see a list of its contents. 

11. Double-click dsk to open it. 

You see a list of its files. 

12. Scroll to the ftlename that describes the ftle system on your CD-ROM. 

For example, if the device is SCSI ID 5 and the file system on the CD-ROM is slice 0, 
the name you want to select is c 5 d 0 sO. And if your device is SCSI ID 4 and the file 
system on the CD-ROM is slice 2, the name you want to select is c4dOs2. 

• Note: The documentation accompanying your CD-ROM states whether the files 
on the disc are divided among different slices. Most likely, all the files are 
contained in one slice. For a disc that keeps all its files in one slice, slice ° is 
likely to be the slice used. 

13. Double-click the ftlename that describes the ftle system on your CD-ROM. 

The filename is selected and you return to the fsentry dialog box. 

14. To specify the directory at which to mount the CD-ROM, click 
"Choose mount point." 

15. To trace your way back to the / directory, press on the current directory 
name displayed at the top of the dialog box and drag to select /. 

The contents of the / folder are displayed. 

16. Click cdrom to select it. Do not double-click it. 

17. Click Directory to select / cdrom as the mount point. 

You return to the fsentry dialog box and are ready to run the command displayed 
in the Command Line box. 

18. Click fsentry. 

You return to the CommandShell window. 
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19. Press RETURN. 

This runs the command. The files on the CD-ROM are now accessible through the 
cdrom folder. 

Installing temporarily 

If you need to reference the information on the CD-ROM only temporarily, meaning from now 
until you next shut down A!UX or unmount the CD-ROM, then mount its files using the mount 

command. This procedure is useful if you intend to copy files from the CD-ROM to a hard disk 
and then disconnect the AppieCD sc. 

• Note: If you mount the CD-ROM with the following steps and then restart the system 
or if you move the system into single-user mode and back into multi-user mode, you 
will unmount the CD-ROM. 

• Figure 5-3 A CD-ROM installed temporarily 
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1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandShell from the Apple menu. 

If a CommandShell window is not displayed, choose New from the File menu. 

3. Type mount and press COMMAND-K. 

The moun t Commando dialog box appears, as shown in Figure 5-4. 

• Figure 5-4 The mount Commando dialog box 

-mountOptions----------------------------------------~ 

: ... Operation .................................................................... ~ r .. Super-user use only .................................. ·, 
I @ Show current status ! l D tlprbDse D B~~l~lj On!!J 
10 List in /etc/fstab format i I D fakp an ~~ntrq 
I 0 Mount entries in /etc/fstab! 1 r .. File system type ........................................ ·1 

~ 0 Mount specified filesystem l II @ lHj t!JP~~s ~ 
;.. ...................................................................................................... .1 11 0 '>qs1 em ~~ HIe ~qs1 (~m~ ~ 

,>pPfir~j Ok ~!Js1 mn 1 (! HHHmL ! ! 0 Him me ~qs1 (~m'~ ! 
[ .......................................................................................................................................................................................................... ] l ~ 0 Nf '> fil~~ S~j~ tpms i 

I 1,.,,, s" '" <m" 1 ;"';" 1 1 (~;:,~;;;;:;:;'~';;:;:;~;;T{~;~~;~~;;~;~;::~ r J 

r.;command Line 
count I 

~
HeIP I [ Cancel 

Mount and dismount file sy stems. Only the superuser may mount a e;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;~ 
filesystem; regular users may only view a report of current mount status. If mount 11 
With no options or arguments, mount prints the current mount table. Il~ .. iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiltll1 

4. From the Operation options, select "Mount specified ftlesystem." 

5. Type the device name that describes your partition. 

You must type the name in the form of /dev/dsk/cndosx) where n is the SCSI ID 
number of the device, and x is the slice number containing the files you want 
to copy. 
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For example, if the device is SCSI ID 5 and the file system is on slice 0, type 
/dev/dsk/c5dOsO 

• Note: The documentation accompanying your CD-ROM states whether the files 
on the disc are divided among different slices. Most likely, all the files are 
contained in one slice. For a disc that keeps all its files in one slice, slice ° is 
likely to be the slice used. 

6. Click "Choose mount point." 

A dialog box displays the available folders in which to place the files. 

7. To trace your way back to the / directory, press on the current directory 
name displayed at the top of the dialog box and drag to select /. 

The contents of the / directory are displayed. 

8. Click mn t to select it. Do not double-click it. 

9. Click Directory. 

Clicking Directory confirms mn t as the chosen directory and closes the dialog box. 

10. Click "Choice of flavors" and then click Read-only. 

11. Click Continue. 

You return to the mount main dialog box and are ready to run the command 
displayed in the Command Line box. 

12. Click mount. 

You return to the CommandS hell window. 

13. Press RETURN. 

This runs the command. The CD-ROM is now mounted. To the user, there is no 
difference between reading the files on the CD-ROM and reading files on a hard disk. 
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Using the A/UX rues on a CD-ROM 

You can reference files on a CD-ROM by opening and reading them, or you can copy them to a 
hard disk where you can change them from read-only files to write able files. 

Opening the flIes 

You can open the files on a CD-ROM from either the Finder or from a CommandS hell window. 

Opening from the Finder 

Follow these steps to open files on a CD-ROM from the Finder: 

1. Display the Finder. 

Choose Finder from the Apple menu if the Finder isn't already displayed. 

2. Double-click the / disk icon, then double-click the folder that contains the 
flIes on the disc. 

For example, if you mounted the CD-ROM on /mnt, double-click the mnt folder. 
And if you mounted the CD-ROM on / cdrom, double-click the cdrom folder. 

The folder opens and shows the files on the CD-ROM. 

3. Double-click a fde to open it. 

If you want to copy files from the CD-ROM to a hard disk, turn to "Copying Files to Disk" later 
in this chapter. 

Opening from a CommandShell window 

Follow these steps to open files on a CD-ROM from a CommandS hell window. 

1. Choose CommandShell from the Apple menu if a CommandS hell window 
isn't already displayed. 

If a CommandShell window is not displayed, choose New from the File menu. 
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2. Enter cd / directoryname 

where directoryname is the name of the directory on which you mounted the 
CD-ROM. 

For example, if you mounted the CD-ROM on Imnt, enter cd Imnt. And if you 
mounted the disc on I cdrom, enter cd I cdr om. 

You have changed directories. 

3. Enter ls -C. 

The files in the current directory are listed in columns. 

4. Double-click a rue to open it. 

The file is opened. Notice the "read-only" message in the window. This message 
reminds you that you can read the file but you cannot make changes (write) to 
the file. 

Copying flIes to disk 

By copying files from a CD-ROM to a hard disk, you can then make changes to the files. 

Files meant to be copied from a CD-ROM to a hard disk can be in one of several formats. The 
following three formats are discussed in this guide: 

• an A/UX file system 

• an archive created with the tar utility 

• an archive created with the cpio utility 

To discover the format of the files on a CD-ROM, read the information accompanying the 
disc. The documentation for the disc explains the format the files are in and how you are to 
list and copy them. In case the documentation does not describe how to copy the files to a 
hard disk, the following subsections are provided. Turn to the section that applies to the file 
format of your CD-ROM and follow the instructions. 
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Files in an A!UX fde system 

Follow these steps if the files are in the form of an A/UX file system: 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. In the Finder, double-click the / disk icon to open it. 

In the next few steps you create a new folder within the /usr / local folder to hold 
the files from the CD-ROM. If you like, you can put the CD-ROM files in another 
directory. However, putting them in the /usr / local folder makes them easily 
accessible to all user accounts on the system. The / u s r / 10 cal directory is 
provided in A/UX to hold programs that you add for use with A/UX, for example a 
Macintosh application to which you want available to all users. 

3. Double-click usr to open it. 

4. Double-click local to open it. 

5. Choose New Folder from the File menu. 

6. Type a name for the folder. 

This folder will hold the files you are copying from the CD-ROM. 

7. Click in the / window to make it active. 

8. Double-click the folder containing the fdes on the CD-ROM. 

For example, if you mounted the CD-ROM at the /mnt directory, double-click mnt. 

9. Select the fde or folder you want to copy. 

10. Drag the fde or folder to the new folder you created in /usr/local. 

The files on the CD-ROM, which you mounted temporarily at the /mnt directory, are 
now in the new folder. 

You are ready to unmount the device. Turn to the section, "Removing the 
AppleCD SC from A/UX" for instructions. 
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Files in a tar archive 

Follow these steps if the files are in the form of a tar archive. 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandShell from the Apple menu. 

If a CommandShell window does not appear, choose New from the File menu. 

3. Enter mkdir /usr/local/directoryname. 

where directoryname is the name of the new directory for the files you are copying 
from the CD-ROM. 

4. Enter cd /usr/local/directoryname. 

Your current directory is now / u s r / 10 cal / directoryname. 

5. If the CD-ROM contains a tar archive but does not contain a ftle system, 
enter the following command. Otherwise, skip to step 6. 
tar xvf /dev/dsk/cndOsX 

where n is the SCSI ID number of the CD-ROM and x is the slice number containing 
the tar archive you want to copy. 

For example, if your CD-ROM is SCSI ID 5 and the file system is slice 0, the name you 
want to select is c5dOsO. And if your CD-ROM is SCSI ID 4 and the file system is 
slice 2, the name you want to select is c4dOs2. 

The files are copied into / u s r / 1 0 cal / directoryname and you are finished with 
this procedure. 

6. If the CD-ROM contains a tar archive and a ftle system, mount the ftle 
system and then copy its ftles using the following steps. 

7. Type mount and press COMMAND-K. 

The mount Commando dialog box appears, as shown in Figure 5-5. 
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• Figure 5-5 The mount Commando dialog box 
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8. In the Operation options click "Mount specified ftle system." 

9. Click in the "Specify ftle system to mount" text box. 

10. Type the device name that describes your CD-ROM. 

You must type the name in the form of / dev / dsk/ cndOsX, where n is the SCSI ID 
number of the device, and x is the slice number containing the files you want 
to copy. 

For example, if the device is SCSI ID 5 and the file system is on slice 0, type 
/dev/dsk/cSdOsO. 

• Note: The documentation accompanying your CD-ROM states whether the files 
on the disc are divided among different slices. Most likely, all the files are 
contained in one slice. For a disc that keeps all its files in one slice, slice ° is 
likely to be the slice used. 

11. Click "Choose mount point." 

A dialog box displays the available folders in which to place the files. 
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12. To trace your way back to the / directory, press on the current directory 
name displayed at the top of the dialog box and drag to select /. 

The contents of the / folder are displayed. 

13. Click mn t to select it. Do not double-click it. 

14. Click Directory. 

Clicking Directory confirms / mn t as the chosen directory and closes the dialog box. 

15. Click "Choice of flavors" and then click Read-only. 

16. Click Continue. 

You return to the moun t main dialog box and are ready to run the command 
displayed in the Command Line text box. 

17. Click mount. 

You return to the CommandShell window. 

18. Press RETURN. 

This runs the command. The CD-ROM is now mounted. 

19. To copy the flIes from the CD-ROM, enter tar xvf /mnt/archivename. 

where archivename is the name of the directory on the CD-ROM containing the files 
you want to copy. 

The files are copied to / u s r / 1 0 cal / directoryname. 

You are ready to unmount the device. Turn to the section, "Removing the 
AppieCD SC from A/UX" for instructions. 

Files in a epio archive 

Follow these steps if the files are in the form of a cpio archive. 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 
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2. Choose CommandS hell from the Apple menu. 

If a CommandShell window does not appear, choose New from the File menu. 

3. Enter mkdir /usr/loeal/directoryname 

where directoryname is the name of the new directory for the files you are copying 
from the CD-ROM. 

4. Enter cd /usr/loeal/directoryname 

Your current directory is now /usr / local/ directoryname. 

5. Enter epio -ivd < /mnt/arcbivename 

where archivename is the name of the directory on the CD-ROM containing the files 
you want to copy. 

The files on the CD-ROM are now in /usr / local/ directoryname. 

You are ready to unmount the device. Turn to the next section, "Removing the 
AppleCD SC from A/UX" for instructions. 

Removing the AppieCD SC from A/UX 

You can remove the AppleCD SC to free the SCSI ID number for other uses. Removing the 
AppleCD SC takes away access to all the files on an inserted CD-ROM. 

If the CD-ROM was mounted permanently 

If the CD-ROM was mounted with fsentry, you need to follow these steps to remove it 
from A/UX. 
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• Note: You cannot unmount a file system if any of its files are in use. This means if you 
are in a directory in the file system that you are trying to unmount, the unmount 
command will fail. It also means if you share the A/UX system with someone, and 
while you are attempting to unmount the CD-ROM that person has a file from the 
disc displayed on screen or in some other way has a file in use, your command to 
unmount the CD-ROM is blocked. 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandS hell from the Apple menu. 

If a CommandShell window is not displayed, choose New from the File menu. 

3. Enter umount /cdrom 

• Note: The command is urnount and not unrnount as you might expect. 

This command unmounts the CD-ROM. 

In the next steps you must open the / etc / f stab file. 

4. In the Finder, double-click the / disk icon to open it. 

5. Double-click et c to open it. 

6. Double-click f stab to open it. 

7. Delete the entry for the CD-ROM. 

It is probably the last line in the / etc / f stab file and looks similar to the 
following line: 
/dev/dsk/c5dOsO /cdrorn 4.2 ro o 2 

8. Save the change and close the ftle. 

9. Click in the CommandS hell window to make it active. 

10. Shut down A!UX by choosing Shutdown from the Special menu. 
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11. Disconnect the AppieCD SC from your Macintosh. 

You need to have a SCSI terminator on the last device in your SCSI chain. If the 
AppleCD SC was the last device on your SCSI chain, remember to replace the 
terminator on the device that is now last on your SCSI chain. 

If the CD-ROM was mounted temporarily 

Follow these steps to unmount a CD-ROM that is mounted temporarily. 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandS hell from the Apple menu. 

If a CommandShell window is not displayed, choose New from the File menu. 

3. Enter umount /mnt 

• Note: The command is umount and not unmount as you might expect. 

This command unmounts the CD-ROM. 

4. Shut down AlUX by choosing Shutdown from the Special menu. 

5. Disconnect the AppieCD SC from your Macintosh. 

You need to have a SCSI terminator on the last device in your SCSI chain. If the 
AppleCD SC was the last device in your SCSI chain, remember to replace the 
terminator on the device that is now last in your SCSI chain. 
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Chapter 6 Adding and Managing the 
Apple Tape Backup 40SC 

You use the Tape Backup 40SC to make backup copies of large amounts 
of data and to receive and install software. A single cartridge tape holds up 
to 38.5 megabytes (MB) of data. 

In this chapter you'll find instructions to 

• add a Tape Backup 40SC to your A/UX system 

• back up and restore partitions with the Tape Backup 40SC software 

• remove a Tape Backup 40SC from an A/UX system 

Backing up a system on a regular basis so that you can reconstruct your 
system after suffering a problem with the system or with a hard disk is a 
very important part of system administration. For information on devising 
a backup plan for your files, as well as procedures to back up data by using 
the A/UX backup utilities, see "Backing Up Your System" in AlUX Local 
System Administration. 
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Connecting a Tape Backup 40SC 

The Tape Backup 40SC is a SCSI (Small Computer System Interface) device that you connect 
to the Macintosh through the SCSI port on the back of the computer. 

As with other SCSI devices-such as hard disks and the AppieCD SC-the way you connect the 
cables varies slightly depending on whether or not you have other SCSI devices connected to 
your Macintosh. Each of the SCSI devices connected to your Macintosh needs a unique SCSI 
ID number , and you may need to place a SCSI terminator on the last device in your SCSI chain. 
See your Apple Tape Backup 40SC Owner's Guide for complete information on connecting the 
tape backup device to your Macintosh. 

Preparing a tape cartridge for use 

Formatting a tape cartridge prepares it to store data. You can format tapes either in the 
Macintosh as or in A/UX, whichever is convenient. 

• Note: If you have Apple tape cartridges, you can skip this section, because Apple 
tape cartridges are formatted at the factory for you. 

It is a good idea to format all unformatted tape cartridges as soon as you receive them. Each 
tape cartridge stores up to 38.5 MB of data. You'll need two tape cartridges to back up a 40 
MB hard disk that is completely full. 

You'll need only two tapes to back up a full 80 MB disk. Two tapes can hold the contents of an 
80 MB disk because approximately 3 MB of a disk is reserved for the disk bookkeeping 
system, leaving about 77 MB of disk space for the data. 

If you don't have two or more formatted tape cartridges before you start backing up a disk 
that contains more than 38 MB of data, you'll have to stop the backup procedure, format a 
tape, and begin the backup procedure again. 
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Formatting a tape cartridge in the Macintosh OS 

To format a tape cartridge in the Macintosh OS, follow these steps. The process lasts about 40 
minutes and must not be interrupted. 

1. In the Macintosh OS, open the Apple Tape Backup 40SC application. 

To open the application, double-click it's icon. If necessary, use Find File on the 
Apple menu to find the application. 

If you can't find the application on your disk, you need to copy it from the floppy 
disk that came with the tape backup device. 

2. Insert the tape into the Tape Backup 40SC drive. 

When you insert the tape cartridge, make sure that the record-lock switch is in the 
unlocked position (to the left). 

Push firmly until the tape cartridge is inside the Tape Backup 40SC. 

It takes about a minute for the tension on the tape to be adjusted. 

3. Follow the instructions in the dialog boxes to complete the formatting 
operation. 

4. Choose Format Cartridge from the File menu . 

... Warning Never eject the tape cartridge while the red activity light is on or 
flashing . .& 

During the formatting process, a status screen, as shown in Figure 6-1, shows you at 
approximately what time the process will be complete. 
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• Figure 6-1 Format Cartridge status screen 

n tape cartridge is being formatted. 
This process takes about 40 minutes 
and cannot be interrupted. The format 
should be complete by: 

2:29 PM 

... Warning Turning off the machine during the formatting operation may 
permanently damage the tape cartridge. If you interrupt the 
formatting, you will need to start the process again and complete 
it before you can use the tape .• 

When formatting is complete, a dialog box asks you to confirm that you're finished. 

5. Click OK. 

6. Eject the tape cartridge by pushing the eject button. 

You are now ready to back up information onto the tape cartridge. 

Formatting a tape cartridge in A/UX 

To format a tape cartridge in A/UX, follow these steps. The process lasts about a minute and 
must not be interrupted. 

1. Insert the tape into the Tape Backup 40SC drive. 

When you insert the tape cartridge, make sure that the record-lock switch is in the 
unlocked position (to the left). 

Push firmly until the tape cartridge is inside the Tape Backup 40SC. 

It takes about a minute for the tension on the tape to be adjusted. 
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2. Display a CommandShell window by choosing CommandShell from the 
Apple menu. 

If a CommandS hell window does not appear, choose New from the File menu. 

3. Enter mt -f /dev/rmt/tcn format 

where n is the SCSI ID number of the tape unit. 

Formatting requires about 30 minutes. After formatting is complete, the 
CommandS hell window reappears. You can copy data onto the tape. 

Using the Apple Tape Backup 40SC software 

Though you can use any of the A/UX backup utilities-tar, cpio, and dump. bsd-to make 
backup tapes on the Apple Tape Backup 40SC, you can also use the Apple Tape Backup 40SC 
software. The Apple Tape Backup 40SC device and software are explained in detail in Apple 
Tape Backup 40SC Owner's Guide. For your convenience, the information from that book on 
backing up A/UX partitions is provided here. 

You can use the commands in the Backup/Restore menu of the Apple Tape Backup 40SC 
application to make a full or "image" backup. Everything in the partition that you select is 
copied, even blank spaces on the disk. You cannot use this utility to back up anything smaller 
than a partition; the Backup Files and Restore Files commands on the menu are available to 
back up only Macintosh files, not A/UX files. 

Each of the Backup/Restore menu commands displays a dialog box. An alert box warns you if 
you are about to do something that could cause you to lose information on the tape and gives 
you a chance either to cancel what you were about to do or to switch cartridges. 
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Backing up partitions 

The Backup Volumes and Partitions command in the Backup/Restore menu lets you copy 
partitions to a tape cartridge or to several cartridges if the partition exceeds 38.5 MB. 
Partitions are divisions of a disk for use with different operating systems or file systems. A 
disk can have one or more partitions. You can select any combination of partitions to back 
up. The application copies all information from each selected partition onto a tape cartridge. 
You can use the copy on the tape cartridge to restore one or more of the partitions at 
any time. 

• Note: Volumes and partitions are very similar, though partition is used in A/UX and 
volume is used in the Macintosh as. 

Plan to start the backup operation when you won't need the computer for at least 30 minutes. 
You can set up the computer to carry out the backup operation while you eat lunch, or at night 
after you go home (as long as you don't need to insert more tape cartridges). 

Follow these steps to back up partitions: 

1. Be sure to have enough formatted tape cartridges on hand to complete 
the backup. 

For information on formatting a tape, see "Preparing a Tape Cartridge for Use," 
earlier in this chapter. 

2. Shut down A/UX and restart the system from the Tape Backup 40SC 
floppy disk. 

With the Finder displayed, choose Shutdown from the Special menu, insert the 
floppy disk into the drive, and press the POWER ON key. 

3. Double-click the Apple Tape Backup 40SC application to open it. 

4. Choose Backup Volumes and Partitions from the Backup/Restore menu. 

A dialog box like the one in Figure 6-2 appears, showing you the volumes and 
partitions available for backup. Each partition is identified by the SCSI ID number 
of its disk drive and its size, name, and type. 
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• Figure 6-2 The Backup Volumes and Partitions dialog box 

Please select the partitions you wish to back: up: 

DRIUE 

(SCSI 0) 
(SCS I 0) 
(SCS I 0) 
(SCSI 0) 
(SCSI 0) 

MAC UOLUME SIZE (K) PARTITION NAME PARTITION TYPE 
MacPartition 2048 MacOS Apple_HFS :Q: 

54561 A!UH Root Rpple_R!UH_SUR2 
18432 Swap Apple_R!UH_SUR2 
3012 Autorecovery 1 Apple_A!UH_SUR2 

Unreserued 1 Apple_A!UH_SUR2 
I nt. Flop ... Untitled 800 

( Cancel) 

5. Select the partitions you want to back up. 

• Note: There is no need to back up the Swap partition. 

D To select an individual partition, click its name. 

D To select a contiguous group of partitions, drag down the list of names, until all 
of the partitions that you want to back up are selected. 

D To select noncontiguous partitions, hold down the SHIFT key and click the 
names of the partitions you want to back up. 

Figure 6-3 presents an example of selecting partitions. 
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• Figure 6-3 Selecting partitions for backup 

Please select the partitions you wish to back up: 

DRIUE MRC UOlUME SIZE (K) PRRTITION NRME PRRTITION TYPE 
IS(SI 01 Ma(Partition 2049 Ma(OS Apple_HFS :B 
1 S( S I 01 54567 A,/UH Root Apple_A,/UH_SLlR2 
(SCSI 0) 
(SCSI 0) 
(SCSI 0) 

18432 Swap Apple_R/UH_SUR2 
3072 Autorecovery 1 Rpple_R/UH_SUR2 

Unreserued 1 Rpple_R/UH_SUR2 

( cancel) 

r je( t hiqhlilJh tPI~ IHsk n Backup )1 

6. Click Backup to begin the backup operation. 

Follow the instructions in the dialog boxes to complete the backup process. 

The application tells you about how many tape cartridges are required for 
the operation. 

During the backup, you see a status screen that reports the progress of the backup 
operation for each partition and the percentage completed for the total operation. 

If your backup session requires more than one tape cartridge, the application 
requests that you reinsert the first tape cartridge at the end of the backup 
operation. The application may also request that you reinsert one of the other tapes, 
such as tape 2 of 4, if the partition you are copying starts on any tape other than the 
first or the last tape cartridge. The application then writes on the first tape cartridge 
a catalog that describes which partitions were copied on which cartridge. This 
process ensures that the backup tapes contain all the information the backup utility 
needs to restore partitions. 
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When the backup is complete, a dialog box asks you to confirm that you 
are finished. 

7. Click OK. 

8. Eject the tape cartridge by pushing the eject button. 

• Note: Any time that you insert a tape cartridge during the backup operation, the 
application checks whether or not the tape cartridge contains data. If the tape 
cartridge contains information, the application displays a warning and allows 
you either to switch the tape cartridge or to cancel the operation. 

You can cancel the backup operation in midstream, if necessary. All the volumes and 
partitions copied before you canceled the operation remain copied onto the tape 
cartridge and can be restored on the hard disk. 

D Important After you copy information onto a tape cartridge, slide the record­
lock switch to the locked position to guard against copying over 
information by accident. L 

Restoring partitions 

You can restore your hard disk if you have a catastrophe that ruins the data on your hard disk 
(and ruins your day). The Restore Volumes and Partitions command in the Backup/Restore 
menu copies the contents of a tape cartridge back onto your hard disk. The contents of the 
hard disk must have previously been backed up on that tape cartridge. 

If your hard disk crashes, you may need to reinitialize the hard disk and then start up from the 
Tape Backup 40SC floppy disk to perform the restore operation. See "Do I Need to Initialize?" 
in Chapter 4, "Adding and Managing Hard Disk SCs," for more information on 
initialiZing disks. 
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Each partition you are restoring from tape should be the same size as the disk partition into 
which you are restoring. If the partition you are restoring from tape is smaller than the disk 
partition into which you are restoring, you stand to lose disk space because the disk partition 
becomes the size of the partition on tape. The maximum disk space you can lose in such a 
situation is 4 MB. The application warns you of any loss of disk space and gives you a chance 
to cancel the operation. You can then repartition the disk before restoring it from tape. To 
create a partition of the correct size, use the Apple HD SC Setup program. See Chapter 4, 
"Adding and Managing a Hard Disk SC," for further instructions on creating partitions. 

Follow these steps to restore a volume: 

1. Shut down A!UX and restart the system from the Tape Backup 40SC 
floppy disk. 

In the Finder, choose Shutdown from the Special menu, insert the floppy disk into 
the drive, and press the POWER ON key. 

2. Double-click the Apple Tape Backup 40SC application to open it. 

3. Insert the rust tape cartridge of your backup into the tape drive. 

4. Choose Restore Volumes and Partitions from the Backup/Restore menu. 

A dialog box like the one in Figure 6-4 appears, showing you the volumes and 
partitions available for the restore operation. You see a list of destinations to which 
the copied information can be restored. For a disk with multiple partitions, the 
dialog box displays each partition as a separate choice. Each "source" partition (the 
copy you made on the tape cartridge) is identified by displaying its partition size, 
name, and type. 
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• Figure 6-4 Restore Volumes and Partitions dialog box 

Select a destination and then its source: 

Destination: (SCSI 5) 

RESlORE MAC UOLUME SIZE (K) PARllTlON NAME PHRllTlON lYPE 

My Macint .. 2048 MacOS Apple_HFS i 
18432 Swap App Ie_A! U H_S U R 2 

~ 
3072 Aulorecovery 1 Ap P le_A!U H_S U R 2 0: 

Source: from tape 

MAC UOLUME SIZE(K) PARTIllON NAME PARllTlON lYPE 

Mu Macint ... 2048 MacOS Apple_HFS Q 
54567 A!UH Root A P P I e_A! U H_S UR 2 
3072 Aulorecovery 1 A pp le_A I U H_S U R 2 

{) 

(Restore) 

( EjPf1 tdqt!Hqt!1 (~d dhk ) (( Cancel J 

5. Select a destination for the partition you want to restore. 

As shown in Figure 6-5, the dialog box then displays a device name or SCSI ID number 
after the selected destination. The SCSI ID number identifies the selected drive. 
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• Figure 6-5 Selecting a destination for a partition restore 

Select a destination and then its source: 

Destination: (SCS I 0) 
RESTORE MAC UOLUME SIZE (K) PARTITION NAME PARTITION TYPE 

I My Macint ... 2048 MacOS Apple_HFS 

~ I I II I II • I I 

l 18432 Swap A p pi e_A! U H_S U R2 
3072 Autorecovery 1 A p pi e_A! U H_S U R2 

Source: from tape 

MAC UOLUME SIZE (K) PARTITION NAME PARTITION TYPE 

l Mll Macint ... 2048 MacOS Apple_HFS ~ 
I 

I 
I III I iJiIr. I I 

I 
3072 Autorecovery 1 Apple_A/UH_SUR2 b 

(Restore) 

[ rj~~e1 tligtlHqtH ed dh·k ) (( Cancel )) 

A destination partition with files that are currently active cannot be selected. 

6. Select a source partition to restore on the selected destination device. 

Only the partitions on the tape that can fit into the selected destination are 
available for selection; partitions on tape that do not fit into the selected 
destination are dimmed. Any source item that is too large, too small, or an 
operating-system type other than A/UX or Macintosh OS is dimmed and cannot 
be selected. 

Each destination can receive only one source item. You can review the selections of 
sources you make by clicking the destination. To undo a selection, first click the 
destination and then click the source. 

You can select several partitions to restore during the same restore operation. As you 
select each source partition, a check mark appears next to its name and the name of 
the selected destination. 
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You can restore each source partition to an individual destination partition or to 
several partitions connected to the same SCSI chain. 

7. Click Restore to begin the restore operation. 

• Note: During the restore operation, the Tape Backup 40SC software reads from 
the tape cartridge and then writes data onto the hard disk. The restore 
operation writes over any data that is currently on the hard disk. Dialog boxes 
warn you of the potential data loss and give you a chance to cancel 
the operation. 

S. Follow the instructions in the dialog boxes to complete the volume 
restore operation. 

When the restore operation is complete, click OK in response to the 
completion message. 

9. Click OK. 

10. Eject the tape cartridge by pushing the eject button. 

11. Restart A/UX. 

You can cancel the restore operation in midstream, if necessary, but the partition being 
restored on the hard disk becomes useless. (Partitions already restored are unaffected.) 
Canceling the restore operation does not alter the copy on the tape cartridge. You can still use 
it to restore your hard disk. However, you may have to reinitialize the hard disk and try the 
Restore Volumes and Partitions command again. 

Removing a Tape Backup 40SC from A/lJX 

Use the following procedure to remove the tape device. 

1. Tum off power to the tape device. 

The power switch is on the back panel. 

2. Shut down A/UX. 

In the Finder, choose Shutdown from the Special menu. 
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3. Disconnect the tape device from the SCSI port. 

4. If the tape device was the last device on a SCSI chain, replace the terminator 
on the device that is now the last device on the chain. 

A/UX is again ready for use. 
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Chapter 7 Adding and Managing Modems 

A modem connects your computer through a telephone line to computers 
beyond the reach of network cables. This chapter describes how to set up 
the Apple Personal Modem and Hayes-compatible modems for use with an 
A/UX system. To set up other types of modems, see the manual 
accompanying your modem. This chapter describes how to 

• set up a modem only to make calls 

• set up a modem to make and receive calls 

• reset a modem only to make calls again 

• remove a modem from an A/UX system 
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What will you use the modem for? 

How you plan to use the modem determines how you need to set it up with A/UX. 

You can easily set up a modem to make calls so that, for instance, you can send reports to your 
home office or read and post articles on an electronic bulletin board (Figure 7-1). If you plan 
to use the modem solely to dial other computers in this way, then it's a good idea not to allow 
any incoming calls. You then have the security of knowing that people cannot read 
information stored on your computer by getting it through the telephone line. This chapter has 
sections on both setting and resetting your system to only make calls. 

Some people require a modem to receive calls; for instance, to receive reports from satellite 
offices. When you receive calls over the modem, the caller has access to your computer as if 
that person were connected directly to your computer via a terminal. If you plan to use your 
modem to receive as well as to make calls, see "Setting Up a Modem to Make and Receive 
Calls." Even if you plan to use your modem only to receive calls, follow the procedures in 
"Setting Up a Modem to Make and Receive Calls," because a modem cannot be easily 
configured to allow incoming but deny outgoing calls. 
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• Figure 7-1 A modem set up only to make calls 

Modem setup only to make calls 

... . . . . . . . 
:. l ... . . . . .. : ~ · · · · · · 

Knowing your communications software options 

Once you set up the modem, you have a choice of software for communicating over it. Many 
Macintosh applications are available for this purpose, but none are included in the A/UX 
distribution, so you'll need to purchase them separately. However, several UNIX 
communications packages are distributed with A/UX, and these are described below. 

• UUCP (UNIX to UNIX Copy) is a good choice if you want to share information with other 
A/UX systems or with other operating systems derived from the UNIX operating system. By 
performing error checking and correction on the data it transmits, UUCP reliably stores and 
forwards information such as mail and files. 

UUCP also lets you execute commands on the distant machine. For example, you can send a 
file on your computer to a printer connected to the system at the other end of the 
telephone line. However, UUCP doesn't let you communicate interactively with the 
remote computer. 
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The drawback with UUCP is the difficulty in setting it up. Allow about a day and a half to 
set up UUCP if it's your first time, and 15 minutes to set it up thereafter. 

UUCP is included with A/UX. See A!UX Network System Administration for information on 
setting up the UUCP system. 

• The cu (call UNIX) program is easier to set up and use than UUCP, and it allows you to 
access non-UNIX systems. The cu program also lets you work interactively on the remote 
computer. Unlike UUCP, however, cu cannot detect errors in transmission and can only 
send ASCII text files. The inability to detect errors also makes c u inadequate for 
transmission over long distances or noisy phone lines. 

When you use cu to log in to another computer over the telephone line, you are treated like 
any other user on that computer. You can also use cu to log in as a terminal to another 
computer that is connected by serial line to your system. 

The cu program is included with A/UX. See A!UX Communications User's Guide 
for information. 

• The s 1 i p program is useful for dialing into a network that uses the TCP lIP protocols. The 
slip program lets you run network programs such as rlogin, telnet, and rcp without 
requiring Ethernet hardware. 

The s 1 i p program is included with A/UX. See A!UX Communications User's Guide and 
A!UX Network System Administration for information. 

• The ke rmi t program is useful for sending information to any computer that's also running 
a kermi t program. It performs error checking for increased reliability. 

The kermit program is included with A/UX. See kermi tOC) in A!UX Command Reference 
or the on-line man page for information. 

Connecting and testing your modem 

How you connect a modem varies according to the brand of modem and type of phone line 
and power source. The Apple Personal Modem User's Manual describes how to connect the 
Apple Personal Modem. It also describes how to test the modem. See the manual that 
accompanies your modem for instructions on connecting the phone line to the modem and 
the modem to your Macintosh computer. 
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D Important Follow the steps in your modem owner's manual to test the modem 
before you configure A/UX for it. Testing the modem at this point 
lets you identify potential problems with your phone line or modem 
before you complicate the setup by attaching your modem to the 
computer. 6 

The following sections describe how to set up a modem. Once you've set up a modem, you 
can easily remove or alter its setup. For example, you can inactivate it, or you can change it 
from making and receiving calls to only making calls. Follow the procedures that match 
your needs. 

Setting up a modem only to make calls 

If you only need to dial into other computers and you don't wish to allow anyone to dial into 
your A/UX system, connect your modem to your Macintosh as described in the modem owner's 
manual. Then you're set up; your modem's already prepared to dial out. Refer to the user's 
guide for your communication software for instructions on dialing other computers and 
transmitting information. 

If you later decide to allow incoming calls, follow the instructions in the next section, "Setting 
Up a Modem to Make and Receive Calls." Should you later decide to disallow incoming calls 
again, follow the instructions in "Resetting a Modem Only to Make Calls." 

Setting up a modem to make and receive calls 

Follow this procedure if you want the modem to make calls to and receive calls from other 
computers. If you are using an Apple Personal Modem you need to perform some additional 
steps provided at the end of this procedure. 
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Follow this procedure as well if you need only to receive calls, though you'll also be able to use 
the modem to make outgoing calls. 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandShell from the Apple menu. 

If a CommandShell window is not displayed, choose New from the File menu. 

3. Type setport and press COMMAND-K. 

The setport Commando dialog box appears, as shown in Figure 7-2. 

• Figure 7-2 The setport Commando dialog box 

rsetport Options -----------------------, 
: ... Logins ......................................... ~ ,.··Ports ......................................... . 

I @ Enable logins I! 0 Modem (ttyO) 

l .. ? ... ~.~.~.~.~.~.~ ... ~.~.~.~.~.~ ........... .1 lOP ri n t e r (t t y 1 ) 

Output 

Error 

fcommand Line 
seotport -r 

![herpO'I':m~ 

... Speed (baud rate) .... ~ 
@ 9600 (terminal) ! 
o 4800 ~ 
02400 ! 
o 1200 (modem) ! 
o 300 ~ 
019200 1 

t ................................................................... ~ 

r;~teal~eorial port; adds or modifieos eontrieos for sl?rial ports in leok/inittab. I [ CanCel) 
NOTE: This command may beo eoxeocuto?d only by a supo?ruso?r. n set port D 

4. Select "Enable logins" from the Logins options. 

This setting allows A/UX to accept incoming calls. 
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5. Select "Modem (ttyO)" from the Ports options. 

This setting tells A/UX which port the modem is connected to. 

If you connected the modem to the printer port, select "Printer (ttyl)" instead. 

6. Select 1200 from the Speed options. 

The speed of transmission (baud rate) is normally 1200 bits per second. 

7. Click setport. 

You return to the CommandShell window. 

8. Press RETURN to run the command. 

A/UX is now ready to send and receive calls through the modem, unless you have an 
Apple Personal Modem. If you have an Apple Personal Modem, you need to continue 
with the next steps. 

6 Important If you are installing an Apple Personal Modem, you need to follow 
steps 9-13 to edit an A/UX system file after running the setport 

command. 6 

9. From CommandShell, begin editing the inittab fue by entering 
TextEditor /etc/inittab 

10. Find the line defining the settings for the modem port. 

It looks like the following line and is probably the second-to-last line in the file: 
00:2:respawn:/etc/getty ttyO at 1200 #Port 0 (modem) 

11. Change getty to apm_getty so that the line looks like this: 
00:2:respawn:/etc/apm_getty ttyO at 1200 #Port 0 (modem) 

If you need instructions on using TextEditor, see A!UX Essentials. 

12. Choose Save then Quit from the File menu to make the change and close 
the fue. 

Now the Apple Personal Modem is ready to make and receive calls. Refer to the user's 
guide for your communication software for instructions on dialing other computers 
and transmitting information. 
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Resetting a modem only to make calls 

This procedure resets a modem that was previously set to both make and receive calls to now 
only make calls. For example, you might want to follow this procedure if you're going on 
vacation and you don't want people logging into your computer via telephone while you 
are away. 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandShell from the Apple menu. 

If a CommandShell window is not displayed, choose New from the File menu. 

3. Type setport and press COMMAND-K. 

The setport Commando dialog box appears, as shown in Figure 7-3. 

• Figure 7-3 The setport Commando dialog box 

rsetport Options --------------------., 
: ... Logins ......................................... ~ 

I @ Enable logins I 
: 0 Disable log ins : 
~ ................................................................... : 

Output 

Error 

fcommand line 
setport -r 

~···Ports ............................................. , 

! D Modem (ttyO) ! 
: D Printer (tty1) : 

; IOlher porls: ~ I 

t ................................................................... l 

r" Speed (baud rate) .... , 
! @ 9600 (terminal) 

: 04800 
! 02400 
: 0 1200 (modem) 

! 0300 

l..9. ... ~ .. ~.~.~.~ ................................... . 

~~t~l~erial port; adds or modifies entries for serial ports in /etclinittab. I ~[ !!!!!!!!!!c!!!a!!!n!!!c!!!el!!!!!!!~ 
1_~OTE : This command may be executed only by a superuser . K~iiiiiiiiiiisiiieiiiit Piiioiiiriiit iiiiiiii~D 
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4. Select "Disable logins" from the Logins options. 

This setting prevents calls from coming in but allows you to call out over the modem. 

5. Select "Modem (ttyO)" from the Ports options. 

This setting tells A/UX which port the modem is connected to. 

If you connected the modem to the printer port, select "Printer (ttyl)" instead. 

6. Click setport. 

You return to the CommandShell window. 

7. Press RETURN to run the command. 

You can now make calls through the modem; however, the modem cannot accept 
incoming calls. 

Removing a modem 

Removing a modem from A/UX frees the serial port for other uses. If you've set up your 
modem only to make calls, you can simply unconnect the modem from your computer to free 
the port; skip the rest of this section. However, if you've set up your system to receive calls, 
disconnect the modem and use the following procedure to stop the A/UX process that has 
been answering the line at that port. 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandShell from the Apple menu. 

If a CommandShell window is not displayed, choose New from the File menu. 

3. Type setport and press COMMAND-K. 

The setport Commando dialog box appears, as shown in Figure 7-4. 
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• Figure 7-4 The setport Commando dialog box 

r-setport Options -----------------------, 
: .. ·Logins ......................................... ~ 

r @ Enable log ins r 

: 0 Disable logins : 
t ................................................................... : 

Output 

Error 

i;command Line 
Letport -r 

,···Ports ............................................. : 

o Modem (ttyO) : 

{~:~n::;t~uyl)~1 
.... Speed (baud rate) .... , 
@ 9600 (terminal) 
04800 
02400 
o 1200 (modem) 
0300 
019200 

-Help------------------, [ Cancel ] 
Set a serial port; adds or modifies entries for serial ports in letc/inittab. ~!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!' 
NOTE: This command may be executed only by a superuser. t set port J 
~-----------------~ 

4. Select "Disable logins" from the Logins options. 

This setting will stop the process that handled incoming calls. 

5. Select "Modem (ttyO)" from the Ports options. 

Only the modem port is disabled. 

If you connected the modem to the printer port, select "Printer (ttyl)" instead. 

6. Click setport. 

7. Press RETURN. 

This runs the command. 

8. Disconnect the modem. 

The serial port is free for other uses. 
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Switching from an Apple Personal Modem to a 
Hayes-compatible modem 

If you set up an Apple Personal Modem to make and receive calls, you entered apm _get ty 

into the /etc/inittab file to enable automatic call answering. The apm_getty setting has 
the same effect on a Hayes-compatible modem; however, most Hayes-compatible modems 
don't require this setting because they are preset to auto-answer mode. If you are switching 
from an Apple Personal Modem to a Hayes-compatible modem, leave apm_get ty in the 
/ etc / in itt ab file unless the Hayes-compatible modem has settings you want to keep and 
with which the apm _get ty setting could interfere. 
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Chapter 8 Adding and Removing Terminals 

If you want to let a second person use your A/UX system simultaneously 
with you, a terminal allows you to do this. A terminal is a device through 
which you interact with the computer, usually by sending input to the 
computer through a keyboard and displaying its output on a screen. You 
can use another computer such as a Macintosh Plus or a Macintosh SE as a 
terminal, or you can use a third-party's dedicated terminal. Whereas user 
accounts let several people use an A/UX system sequentially, terminals 
extend this capability to allow several people to use a system 
simultaneously. 

In this chapter you'll learn how to 

• add a Macintosh Plus or Macintosh SE as an A/UX terminal 

• remove one of these terminals from A/UX 

For information on adding a third-party terminal to A/UX, see 
AlUX Local System Administration. 
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Limitations of using a terminal 

You will encounter the following restrictions if you interact with A/UX through a terminal (such 
as a Macintosh Plus running a terminal emulator program) instead of through the main console 
(that is, the keyboard, mouse, and monitor of the Macintosh running A/UX): 

• You cannot use the A/UX Finder or the mouse on the terminal; you can use only the 
command-line interface. 

• You cannot run any Macintosh applications on your A/UX system from the terminal. These 
applications run in the window environment available through the A/UX Toolbox; however, 
terminals cannot access the A/UX Toolbox. 

Usefulness of a terminal 

While someone else is running a Macintosh application at the console, you can run any of 
A/UX's standard UNIX applications, such as the vi editor, on a terminal. You can also do any 
of the A/UX procedures described in this guide, but not with the Commando interface. 
Instead, you must use the scripts with the command-line interface as described in 
A!UX Local System Administration. 

A terminal is also well suited for performing system administration tasks using the traditional 
command-line interface. A terminal is especially helpful when you have problems with a 
program you're running on the console. If the program running on the console causes the 
computer to "freeze" (that is, if the computer won't respond to your commands), then you 
can enter a command from the terminal to stop that program (in UNIX terms, to "kill" the 
process running on the console). 
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Effect on system performance 

You can connect multiple terminals to one A/UX computer, but system performance 
deteriorates with each additional terminal. Constraints on the number of terminals you can 
have include the amount of RAM in your A/UX system, the demand your applications make on 
system resources, and the level of system performance you require. 

Acceptable system performance is a matter of personal preference. However, you can usually 
achieve satisfactory performance with one terminal added to an A/UX system configured with 
a minimum of 5 MB of RAM. 

Adding a Macintosh plus or Macintosh SE as a terminal 

You follow the same procedure whether you are adding a Macintosh Plus or a Macintosh SE to 
a Macintosh computer running A/UX. The procedure requires the following steps: 

• connecting the Macintosh Plus or Macintosh SE to the Macintosh running A/UX 

• running a terminal emulator program, such as MacTerminal®, on the Macintosh Plus or 
Macintosh SE 

• running a script to inform A/UX that a terminal is connected 

What you need 

To connect a Macintosh Plus or a Macintosh SE as a terminal, you need the following: 

• an Apple serial cable (Figure 8-1), such as a Macintosh Plus System to ImageWriter II cable, 
with mini-8 connectors at both ends. 
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• Figure 8-1 The cable to connect a Macintosh Plus or Macintosh SE 

• a terminal emulator program for the Macintosh Plus or Macintosh SE, such as MacTerminal. 
(MacTerminal is available from your authorized Apple dealer.) 

Making the hardware and software connections 

Follow these steps to set up your hardware and configure your software: 

1. Plug one end of the cable into a serial port on the back of the Macintosh 
computer running A/UX. 

The serial ports are identified with icons of a modem (represented by a telephone 
handset) and a printer. You can use either serial port. You can use the modem port if 
a printer is connected to the computer running A/UX, or use the printer port if a 
modem is connected. 

2. Plug the other end of the cable into the corresponding serial port on the 
back of the Macintosh plus or Macintosh SE computer. 

The icons used to identify the serial ports are the same as those on the back of the 
A/UX computer. 

3. Plug the Macintosh plus or Macintosh SE into a power source. 

See the Macintosh Plus or Macintosh SE owner's guide if you need instructions. 

4. Turn on the Macintosh Plus or Macintosh SE. 

The power switch is on the back panel. 

5. Open MacTerminal or another terminal emulator program on the Macintosh 
plus or Macintosh SE. 
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6. Select the following settings in the terminal emulator program. 

For example, if you're using MacTerminal, choose Terminal and Compatibility from 
the Settings menu and select the following settings: 

o terminal type: VT100 

o line width: 80 columns 

o mode: ANSI 

o baud: 9600 

o bits per character: 8 

o parity: none 

o connection port: modem (Select printer instead if you'll be connecting the terminal 
through the printer port.) 

o connection: to another computer (that is, instead of to a modem) 

o handshake: XON/XOFF 

7. On the Macintosh running A!UX, log in as root to become the superuser. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

8. Open a CommandS hell window by choosing CommandS hell from the 
Apple menu. 

If a CommandS hell window doesn't appear, choose New from the File menu. 

9. Type setport and press COMMAND-K. 

The setport Commando dialog box appears. 
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• Figure 8-2 The setport Commando dialog box 

-setport Options -----------------------, 

:···logins·········································, 
l @ Enable log ins l 
I 0 Disable logins : 
t .................................................................. J 

Output 

Error 

fcommand Line 
setport -r 

,···Ports ............................................. : 

i D Modem (ttyO) I 
! D Printer (tty 1) I 

,[herp:rt':mm~J 

r·· Speed (baud rate) .... ) 
: @ 9600 (terminal) : 
: 04800 I 
: 02400 1 

i 0 1200 (modem) I 
l0300 : 
: 0 19200 i 
t ................................................................... : 

ls~t~I~E'rial port; adds or modifiE'S E'ntries for sE'rial ports in IE'tc/inittab. I e[~!!!c!!!a!!!n!!!c!!!e!!!1 ~~) 
I NOTE: This command may bE' E'xE'cutE'd only by a supE'rusE'r. nllQo;;;;;;iiiiiisiiiie;;;;it Piiiioiiiiriiiit iiiiii~B 

In the next step, you tell A/UX through which serial port you connected the terminal. 

10. Select "Modem (ttyO)" or "Printer (tty1)" from the Ports options. 

If your Macintosh running A/UX is connected at its modem port, select "Modem 
(ttyO)." If it's connected at its printer port, select "Printer (ttyl)." 

11. Select 9600 from the Speed options. 

Now you're ready to run the command. 

12. Click setport. 

You return to the CommandShell window. 

13. Press RETURN to run the command. 

14. Check the screen of the Macintosh Plus or Macintosh SE computer. You 
should see a login prompt. 
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If you see a login prompt in your terminal emulator program, log in as the root user 
or log in to any user account to test the connection. After entering the password, 
press RETURN to accept VT100 as the type of terminal. Your Macintosh Plus or 
Macintosh SE is now functioning as a terminal for A/UX. 

If you don't see a login prompt, check the cable connections. Check that your 
settings on the terminal emulator program match those listed in step 6 of this 
procedure. If those are correct and you still see no login prompt, check that you 
have configured the software for the terminal to use the port that connects it to the 
A/UX computer. Then check that the port to which the A/UX computer is connected 
to the terminal matches the one you selected in the setport Commando 
dialog box. 

Removing a Macintosh Plus or Macintosh SE from A/UX 

To remove a Macintosh Plus or Macintosh SE serving as terminal to A/UX, follow these steps: 

1. Log in to the root account. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Choose CommandS hell from the Apple menu. 

If a CommandShell window is not displayed, choose New from the File menu. 

3. Type setport and press COMMAND-K. 

The setport dialog box appears, as shown in Figure 8-2. 

4. In the area labeled "Logins" click "Disable logins." 

This stops the process that enables logins at the port you select in the next step. 

5. In the area labeled "Port" click "Modem (ttyO)" or "Printer (ttyl)." 

If your Macintosh running A/UX is connected at its modem port, select "Modem 
(ttyO)." If it's connected at its printer port, select "Printer (ttyl)." 

6. Click setport. 

7. Press RETURN. 
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8. Disconnect the cable between the two computers. 

The serial port is free for other uses. 

When you again want to use one of these computers as a terminal, follow the setup procedure 
in this chapter. You don't need to reenter the terminal emulator program settings if they 
haven't changed. 
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Chapter 9 Connecting Your Computer 
to a Network 

This chapter describes how to connect your A/UX system to an existing 
network system. It doesn't describe how to design and set up a network; 
this job belongs to your network administrator. 

This chapter contains the following sections: 

• what a network offers 

• identifying your network 

• networking options 

• setting upon Ethernet 

• testing the network connection 

• using networked printers via Ethernet 

• what's available now 

You'll need to obtain some information from your network administrator 
to complete the procedures in this chapter. For an in-depth look at 
network setup and configuration, see AlUX Network System 
Administration. 

For more information on network basics, such as what kinds of networks 
can be set up and how networks operate, see the Addison-Wesley 
publication, Understanding Computer Networks (Addison Wesley 
Publishing Company, 1989). 
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What a network offers 

You may want to connect your computer to a network of computers. Over this network you 
can communicate with other users and share system resources, such as printers, files, and 
application programs. For example, a single printer on a network can be made available to 
users throughout an office building. Network software such as AppleShare® allows you to 
access a library of software tools for a wide range of business tasks . You can also use this 
network to send electronic mail to other users on the system. 

Now that you know something about what's available on a network, continue to the next 
section to determine which kind of network cabling is available at your site. 

Identifying your network 

A/UX supports both LocalTalk and EtherTalk®, so the computers on your network may be 
connected by either LocalTalk or Ethernet cables. 

If your cable looks like Figure 9-1, you have LocalTalk. Hardware support for LocalTalk is built 
into all Macintosh computers. 

• Figure 9-1 LocalTalk connection 

~ 
;~oo 

8-pin mini-circular port and plug 

QEillP~==::::::j9 QEillP~===S======~~ 
'---~ 

8-pin plug Connector box Cable extender 
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If your cable looks like Figure 9-2, you have Ethernet. To connect with Ethernet, your system 
must have an Ethernet card, such as the EtherTalk NB card. 

• Figure 9-2 Ethernet connection 

BNC T-connector for thilJ----------_____ 
Ethernet cable 

DB-1S connector for thick---~ 
Ethernet cable ~ 

Now that you've determined the type of network cable you have, continue to the next section 
for a description of the available networking options. 

Networking options 

Depending on whether you have Ethernet, LocalTalk, or both, here is an overview of the 
procedures for connecting to either or both networks: 

• connecting to LocalTalk 
As an A/UX user, you might wish to use LocalTalk in order to use an AppleTalk printer. If 
this is the only network you will be using, first connect your system as described in 
LocalTalk Cable System Owner's Guide, which is in the LocalTalk connector kit. Next see 
Chapter 7 of AlUX Essentials for information on how to select an AppleTalk printer. 
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• Note: You can also use a LocalTalk cable to connect a printer directly to your system 
instead of using a printer on the network. See Chapter 3 for instructions. 

LocalTalk also enables you to use a number of additional network services. For information 
on these additional services available over LocalTalk, refer to the guide that comes with 
the software (such as an electronic mail program) or with the piece of equipment you'll be 
using on your network. 

• connecting to Ethernet 
As an A/UX user, you might wish to connect to the Ethernet-based TCP/IP (B-NET) 
network. A/UX supports Yellow Pages and the Network File System (NFS) facility, giving 
you the ability to share network resources with a wide variety of machines. Also, if the 
Ethernet is connected to another network that has AppleTalk printers, you can set up your 
system to use printers on that AppleTalk network too. 

In order to connect to the Ethernet, you first need to install an Ethernet card as described 
in the guide Macintosh EtherTalk Interface Card) that came with the EtherTalk NB card. 
Follow the instructions in that manual to install the card and physically connect your system 
to the Ethernet network. Or, if you have some other Ethernet card, see the directions that 
came with that card. After you install the Ethernet card proceed to the section "Setting Up 
A/UX for Ethernet." 

• connecting to both LocalTalk and Ethernet 
If you have Ethernet and LocalTalk cables, you may wish to connect to them both in order 
to get access to both the Tep /IP network over the Ethernet and AppleTalk printers over 
LocalTalk. If you choose to do this, first install an Ethernet card as described in the guide 
Macintosh EtherTalk Interface Card, that came with the EtherTalk NB card. Follow the 
instructions in that guide to install the card and physically connect your system to the 
Ethernet network. Or, if you have some other Ethernet card, see the directions that came 
with that card. After you install the Ethernet card proceed to the section "Setting Up A/UX 
for Ethernet." 
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Setting up A/UX for Ethernet 

After you install an Ethernet interface card and connect the Ethernet cables, you can set up 
A/UX files to communicate with other machines and share resources on the TCP lIP network. 
Follow these steps: 

1. Collect the necessary network addressing and services information from 
your network administrator. 

Check with your network administrator to get the following information about 
your system: 

D your Internet address (a number such as 192 . 33 . 20 . 1) 

D Important Each Internet address number conveys important information that 
can affect a large number of network users, so be sure to use 
legitimate numbers. Do not make up numbers. 

If you haven't yet received your official Internet address number and 
your network is not connected to any other networks, you may use 
the number 1 92 . 33 . 2 0 . n, where n is 1 or higher . Your machine 
must be the only one on the network that has this number. D 

D the Internet address of another machine that is running on the network 
You'll use this address to test that your machine is working on the network. 

D an Internet broadcast address 
Typically this is your Internet address, with 255 in place of the last digits. If you 
haven't received an official number, use 192. 33 . 20 . 255. 

D a netmask 
If you don't have an official netmask, use none. 

In a network with multiple subnets, the netmask enables the system to identify 
local machines, thereby keeping local traffic off the general network. An 
example netmask is OxfffffcOO (zero followed by eight hex digits). 
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D a host name, which is a unique name that identifies your system 

D a yp domain name if you are using Yellow Pages 

2. Log in to the root account to become the superuser. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

3. Open a CommandS hell window if one isn't already on the desktop. 

In the Finder, choose CommandShell from the Apple menu. 

4. Enter newconfig nfs 

• Note: If you know that you don't want NFS, you can save space on your system 
by entering the newconfig bnet command instead, which causes the system 
to skip the Yellow Pages prompt mentioned later in this step. 

The system prompts you to indicate whether you want to use Yellow Pages: 
Do you want this machine to be a Yellow Pages client? (y or 
n) [default :n] 

5. Enter n or press RETURN. 

This procedure assumes that you aren't running Yellow Pages. 

If you haven't already set a host name, the system prompts you for one: 
Please enter a hostname (it must be unique) : 

6. Enter your host name. 

You can enter any host name you choose, as long as it meets these conditions: 

D The name must be no longer than 31 characters. 

D The name must be unique on the network. 

D The name must not contain any special characters such as !, \, ? or *. 

7. Enter additional information as prompted. 

If the information hasn't been previously entered, the system prompts you to enter 
the information you got from your network administrator: your Internet address, 
Internet broadcast address, and netmask. 
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• Note: If Internet address and netmask information has been previously entered 
and you would like to change them to new values, use the rrn command to 
remove the existing files: 
rrn /etc/HOSTNAME 

rrn /etc/NETADDRS 

If you use the rrn command to remove existing files, run the newconfig nfs 

command. In response, the system automatically creates the / etc/HOSTNAME 

and / etc/NETADDRS files when you enter the Internet address and host name. 

8. To verify that the system is set up to handle the UNIX mail utility, check 
the rue /ete/ inittab. 

Use TextEditor, vi, or another text editor to open the /etc/inittab file. Find 
this line: 
net8:2:onee:/usr/lib/sendrnail -bd -q30rn 

If the line contains off instead of once, change off to once, then save and close 
the file. 

9. To use AppleTalk printers over the Ethernet, switch from LocalTalk 
to EtherTalk. 

The remainder of this step describes how to enable printing on AppleTalk printers 
that are available on the internet via Ethernet. This process disables AppleTalk 
printing from the LocalTalk port. If you are connected to LocalTalk for AppleTalk 
printer access, skip to step 9. 

To enable AppleTalk printing via Ethernet, enter 
/etc/appletalk -d 

Then use TextEditor, vi, or another text editor to open the / etc/ appletalkrc 

file, and change the line: 
interface = localtalkO 

to 
interface = ethertalkO 

10. Choose Restart from the Special menu. 

The system restarts (reboots), and the changes take effect. 
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Testing the network connection 

Follow these steps to check that your system has a working connection to the network: 

1. Log in to the root account to become the superuser. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Enter telnet loop 

After a short time, the login prompt appears 
Apple Computer, Ine. A/UX (hostname) 

login: 

3. Press CONTROL-D to escape from the login prompt. 

If the login prompt doesn't appear in several seconds, see your network 
administrator. For details on network tests see Chapter 9, "Tools for Checking 
System Status," in A!UX Network System Administration. 

4. Test communications over the network. 

To check whether your system can communicate across the network, you need to 
know the name of another system on the network. Get this information from 
another user or from your network administrator. Use the command 
/usr jete/ping address 

where address is the address of another network computer. For example, if 
192 . 33 .20.2 is the address of another system already on the network, you 
would enter 
/usr/ete/ping 192.33.20.2 

If the network and both hosts are functional, a display like this appears 
64 bytes from 192.33.20.2: iemp seq=O. 

-

64 bytes from 192.33.20.2: iemp seq=l. -
64 bytes from 192.33.20.2: iemp seq=2. -
64 bytes from 192.33.20.2: iemp seq=3. 

-
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Stop the display by pressing CONTROL-C. Some statistics appear, then the system 
prompt, as shown here: 
----hostname1 PING Statistics----

6 packets transmitted, 6 packets received, 0% packet loss 

round-trip (ms) min/avg/max = 16/16/16 

hostname% 

Using networked printers via Ethernet 

If the network to which you are now connected includes AppleTalk printers, you can select 
one if these printers as described in Chapter 3, "Adding and Managing Printers," or in Chapter 7 
of AlUX Essentials. 

If your network includes other UNIX hosts that support lpr, you can use a printer on the 
remote host by completing these steps: 

1. Log in to the root account to become the superuser. 

See "Becoming the Superuser" in Chapter 1 if you need instructions. 

2. Open the ftle /etc/printcap. 

Use TextEdit, or vi, or the text editor of your choice. 

3. Find the RemoteHost line. 

The RemoteHost line is in the section that refers to the remote UNIX line printer, as 
in the last line of this example: 
#Remote UNIX line printer 
#Change 'RemoteHost' to actual name of remote UNIX host 
remoteiremote line printer:\ 

: lp=:rm=RemoteHost:sd=usr/spool/lpd/Remote 

4. Replace RemoteHost with the name of the remote UNIX system 
connected to the printer you intend to use. 

For example, if the name of the remote host is Thad, edit the line to look like this: 
:lp=:rm=Thad:sd=usr/spool/lpd/Remote 
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Editing the line as shown above causes Ipr commands sent to the remote host to be 
automatically printed out on the default printer of the computer named Thad. 

5. If you wish, specify a printer other than the host default printer. 

For example, to print files on the printer named Bos, insert the name of the printer 
and the name of the remote host (Thad) on the RemoteHost line, as shown here: 
:lp=:rp=Bos:rrn=Thad:sd=usr/spool/lpd/Rernote 

6. Save the /etc/printcap rue. 

7. Choose Restart from the Special menu. 

The changes are put into effect. 

Now you can use the remote UNIX printer by entering the Ipr command in this format: 

Ipr -Prernote fikname 

See Chapter 7 in A!UX Essentials for additional printing information. 

What's available now 

Now that you've completed the basic steps for putting your system on the network, you can 
send and receive mail and use remote printers. Also, A/DX includes AppleShare client software. 
If an AppleShare file server is on the network, you can use the AppleShare services. See the 
AppleShare User's Guide for information on using AppleShare. 

Several other network services are available, for instance, you can make your files available to 
other network users, and access other network services. To implement these options, see your 
network administrator for specifics on your network configuration. 

See A!UX Network System Administration for complete information about network setup and 
management, as well as information on adding services such as Yellow Pages. 
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4-14 to 4-21 
partitioning for A/UX user files and the 

Macintosh as 4-11 to 4-14 
partitioning for user files only 4-8 to 4-11 
preparing 4-5 to 4-30 
removing 4-43 to 4-44 
salvaging a problem disk 4-6 

Hard Disk Sc. See hard disks, SCSI 
Hayes-compatible modem, switching to from 

an Apple Personal modem 7 -11. 
See also modems 

HD SC Setup. See Apple HD SC Setup 
host name requirements 9-6 

I, J 
ImageWriters 

adding 3-4 to 3-8 
connecting with a serial cable 3-7 
connecting with LocalTalk 3-5 to 3-6 
effect on personal System Folders 3-6 
LocalTalk card, installing in a 3-5 
printing a file 3-9 to 3-10 
testing 3-8 

Internet address 9-5 
Internet broadcast address 9-5 

K 

kermi t over a modem 7-4 
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L 

LaserWriters 
adding 3-2 to 3-4 
AppleTalk Active button 3-4 
connecting 3-2 to 3-4 
effect on personal System Folders 3-4 
LocalTalk system connector kits 3-2 to 3-3 
printing a file 3-9 to 3-10 
printing a test page 3-3 
testing 3-8 

LaserWriter II NIX, storing fonts for 3-3 
LocalTalk 

connecting a LaserWriter directly to your 
computer 3-2 to 3-3 

connecting an ImageWriter directly to your 
computer 3-5 to 3-6 

expanding the one computer and one printer 
network 3-5 

identifying the cables 9-2 to 9-3 
system connector kit 3-2 

LocalTalk Card, installing in an ImageWriter 3-5 
LocalTalk system connector kit 3-2 to 3-3 

M 

MacDriver partition 4-10 
Macintosh applications, adding to AlUX 5-11 
Macintosh computers as terminals 8-3 to 8-8 

adding 8-4 
removing 8-7 to 8-8 
testing the connection 8-7 

MacPartition 4-2 
MacTerminal 8-4 

settings for a terminal 8-5 
testing the connection 8-7 

mail 9-2, 9-7 
modems 7-1 to 7-11 

about 7-1 to 7-2 
baud rate 7-7 
communications software options 7-3 
connecting 7-4 
and cu 7-4 
enable logins 7-6 

modems (continued) 
and kermi t 7-4 
resetting to only make calls 7-8 to 7-9 
setting only to make calls 7-5 
setting to make and receive calls 7-5 to 7-7 
and slip 7-4 
switching from an Apple Personal to a 

Hayes-compatible 7 -11 
and uuCP 7-3 to 7-4 

mount command 
and single- and multi-user modes 5-6 
mounting a file system on a CD-ROM 

5-6 to 5-8 
mounting a file system on a Hard Disk SC 

4-34 to 4-43 . 
mount Commando dialog box 

installing the AppieCD SC temporarily 
5-7,5-13 

mounting a file system on a Hard Disk SC 4-3( 
mounting a file system on a CD-ROM 

mounting permanently 5-2 to 5-6 
mounting temporarily 5-6 to 5-8 

mounting a file system on a Hard Disk SC 
4-34 to 4-43 

about 4-34 
choosing a directory at which to mount 

4-40, 4-43 
copying the directory to be replaced 4-37 
copying the files in the existing directory 4-35 
at an existing directory 4-35 to 4-41 
permanently with the fsentry script 

4-34, 4-38 to 4-41, 4-43 
at a new directory 4-41, 4-43 
recreating the directory 4-38 
removing the old directory 4-38 
unmounting temporarily 4-37 

mt (magnetic tape) command 6-5 

N,O 

netmask 9-5 
network administration 9-1, 9-5, 9-8 
Network File System 9-4 
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networks 9-1 to 9-10. See also Ethernet; 
LocalTalk 

advantages of 9-2 
printers on 9-9 
software setup for Ethernet 9-5 to 9-7 
TCP/IP 9-4 
testing 9-8 to 9-9 

newconfig 9-6 
newf s command 4-31 
newfs Commando dialog box 4-32 
NFS (Network File System) 9-4 

P, Q 
partitioning hard disks 

adjusting partition sizes 4-22 to 4-30 
advice about / u s r 4-4 
advice when partitioning for user files 

4-3 to 4-4 
allowing for overhead space 4-2 
connecting the device 4-5 
difference between partitions and file systems 

4-2 to 4-3 
dp utility 4-2 
free space 4-28 
partitioning schemes and disk sizes 4-7 to 4-8 
planning 4-2 
for user files and /usr 4-14 to 4-21 
for user files and the Macintosh as 

4-11 to 4-14 
for user files only 4-8 to 4-11 
for X Window System 4-2 

partitions 4-3 
backing up to tape 6-5 to 6-6 
changing sizes 4-22 to 4-30 
creating. See partitioning hard disks 
how different from file systems 4-2 to 4-3 
sizes of when restoring 6-10 

printers 3-1 to 3-10 
connecting a LaserWriter 3-2 to 3-3, 3-4 
adding an ImageWriter 3-6 
adding a LaserWriter 3-4 
LaserWriters and the AppleTalk Active button 

3-4 

printers (continued) 
LocalTalk card, installing in an ImageWriter 

3-5 
LocalTalk system connector kits 3-2 
non-Apple 3-1 
selecting a LaserWriter with the Chooser 3-4 
selecting on a network 9-9 
supported by AiUX 3-1 
using on a network 9-9 

printing a file 3-9 to 3-10 

R 

with AiUX print utility, lpr 3-10 
the Macintosh way 3-9 to 3-10 

removing a user account 2-9 to 2-10 
removing devices 

AppleCD SC 5-15 to 5-17 
Hard Disk SC 4-43 to 4-44 
Macintosh computer as a terminal 8-7 to 8-8 
modems 7-9 to 7-10 
Tape Backup 40SC 6-13 to 6-14 

Restore Volumes and Partitions command 6-9 
root account 1-4 

s 
scripts 1-2 to 1-3 
SCSI hard disks. See hard disks, SCSI 
SCSI port 1-8 

maximum number of devices 1-9 
serial cable for ImageWriters 3-7 to 3-8 
serial port, connecting an ImageWriter to 3-7 
setport Commando dialog box 

setting up a modem only to make calls 7-8 
setting up a modem to make and receive calls 

7-6 
adding a terminal 8-6 
removing a modem 7-10 

settings in MacTerminal 8-5 
slice numbers 

on a CD-ROM 5-5, 5-8, 5-13 
and disk partitions 4-34 

slip over a modem 7-4 
software required for a terminal 8-4 
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subnets 9-5 
superuser 

and root account 1-4 
how to become 1-6 
versus normal user 1-4 

system administration on a terminal 8-2 
system administrator 1-3 
System Folders 

T 

effect of adding a LaserWriter 3-4 
effect of adding an ImageWriter 3-6 

tape drive. See Apple Tape Backup 40SC drive 
tape cartridges 

Apple tape cartridges 6-2 
capacity 6-2 
formatting in NUX 6-4 to 6-5 
formatting in the Macintosh as 6-3 to 6-4 

tar archives on CD-ROMs 5-12 
TCP lIP network 9-4 
terminal emulator programs 8-5 
terminals 8-1 to 8-7 

adding 8-3 to 8-7 
effect on system performance 8-3 
hardware and software required 8-3 
limitations of 8-2 
and Macintosh-style applications 8-2 
removing 8-7 to 8-8 
usefulness of 8-2 

testing the network 9-8 

u 
Useful Commands folder 2-3 
user accounts 

adding 2-3 to 2-7 
choices when creating 2-2 to 2-3 
default settings of the adduser script 2-2 
file permissions 2-2 
global System Folder 2-2 
home directory 2-2 
login names 2-5 
login shell 2-2 
modifying 2-7 

user accounts (continued) 
passwords 2-9 
purpose 2-2 
removing 2-9 to 2-10 
specifying a group or the login shell 2-7 to 2-9 
telephone numbers and address 2-6 

user files 4-3. See also partitioning hard disks 
UUCP over a modem 7-3 to 7-4 

v, W,X 

volumes 6-6. See also partitions 

Y,Z 

Yellow Pages 9-4,9-6, 9-10 
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